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Introduction 

Microsoft Visual C# is a powerful but simple language aimed primarily at developers 
creating applications by using the Microsoft .NET Framework. It inherits many of the 

best features of C++ and Microsoft Visual Basic, but few of the inconsistencies and 
anachronisms, resulting in a cleaner and more logical language. The advent of C# 2.0 

has seen several important new features added to the language, including Generics, 
Iterators, and anonymous methods. The development environment provided by 

Microsoft Visual Studio 2005 makes these powerful features easy to use, and the many 
new wizards and enhancements included in Visual Studio 2005 can greatly improve your 

productivity as a developer. 

The aim of this book is to teach you the fundamentals of programming with C# by using 

Visual Studio 2005 and the .NET Framework. You will learn the features of the C# 
language, and then use them to build applications running on the Microsoft Windows 

operating system. By the time you complete this book, you will have a thorough 
understanding of C# and will have used it to build Windows Forms applications, access 

Microsoft SQL Server databases, develop ASP.NET Web applications, and build and 
consume a Web service. 

Part I 
Introducing Microsoft Visual C# and Microsoft Visual Studio 2005 
 

Chapter 1 
Welcome to C# 

After completing this chapter, you will be able to: 

• Use the Visual Studio 2005 programming environment. 
• Create a C# console application. 

• Use namespaces. 

• Create a C# Windows Forms application. 

Microsoft Visual C# is Microsoft's powerful, component-oriented language. C# plays an 
important role in the architecture of the Microsoft .NET Framework, and some people 

have drawn comparisons to the role that C played in the development of UNIX. If you 
already know a language such as C, C++, or Java, you'll find the syntax of C# 

reassuringly familiar because it uses the same curly brackets to delimit blocks of code. 
However, if you are used to programming in other languages, you should soon be able 

to pick up the syntax and feel of C#; you just need to learn to put the curly brackets 
and semi-colons in the right place. Hopefully this is just the book to help you! 

In Part I, you'll learn the fundamentals of C#. You'll discover how to declare variables 
and how to use operators such as plus (+) and minus (-) to create values. You'll see 

how to write methods and pass arguments to methods. You'll also learn how to use 
selection statements such as if and iteration statements such as while. Finally, you'll 

understand how C# uses exceptions to handle errors in a graceful, easy-to-use manner. 
These topics form the core of C#, and from this solid foundation, you'll progress to more 

advanced features in Part II through Part VI. 
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Beginning Programming with the Visual Studio 2005 Environment 

Visual Studio 2005 is a tool-rich programming environment containing all the 
functionality you'll need to create large or small C# projects. You can even create 
projects that seamlessly combine modules from different languages. In the first 

exercise, you'll start the Visual Studio 2005 programming environment and learn how to 
create a console application. 

Create a console application in Visual Studio 2005 
 

 

 

1. In Microsoft Windows, click the Start button, point to All Programs, and then point 
to Microsoft Visual Studio 2005. 

2. Click the Microsoft Visual Studio 2005 icon. Visual Studio 2005 starts. 

NOTE 

If this is the first time that you have run Visual Studio 2005, you might see a 
dialog box prompting you to choose your default development environment 

settings. Visual Studio 2005 can tailor itself according your preferred development 
language. The various dialog boxes and tools in the integrated development 

environment (IDE) will have their default selections set for the language you 
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choose. Select Visual C# Development Settings from the list, and then click the 

Start Visual Studio button. After a short delay, the Visual Studio 2005 IDE 
appears. 

3. On the File menu, point to New, and then click Project. The New Project dialog box 

opens. This dialog box allows you to create a new project using various templates, 
such as Windows Application, Class Library, and Console Application, that specify 

the type of application you want to create. 

NOTE 

The actual templates available depend on the version of Visual Studio 2005 you 
are using. It is also possible to define new project templates, but that is beyond 

the scope of this book. 

 

 

4. In the Templates pane, click the Console Application icon. 

5. In the Location field, type C:\Documents and Settings\YourName\My 
Documents\Microsoft Press\Visual CSharp Step by Step\Chapter 1. 

Replace the text YourName in this path with your Windows user name. To save a 
bit of space throughout the rest of this book, we will simply refer to the path 

“C:\Documents and Settings\YourName\My Documents” as your “\My Documents” 
folder. 
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NOTE 

If the folder you specify does not exist, Visual Studio 2005 creates it for you. 

6. In the Name field, type TextHello. 
7. Ensure that the Create Directory for Solution check box is checked and then click 

OK. The new project opens. 

 

The menu bar at the top of the screen provides access to the features you'll use in the 
programming environment. You can use the keyboard or the mouse to access the menus 

and commands exactly as you can in all Windows-based programs. The toolbar is 
located beneath the menu bar and provides button shortcuts to run the most frequently 

used commands. The Code and Text Editor window occupying the main part of the IDE 
displays the contents of source files. In a multi-file project, each source file has its own 

tab labeled with the name of the source file. You can click the tab once to bring the 
named source file to the foreground in the Code and Text Editor window. The Solution 

Explorer displays the names of the files associated with the project, among other items. 
You can also double-click a file name in the Solution Explorer to bring that source file to 

the foreground in the Code and Text Editor window. 
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Before writing the code, examine the files listed in the Solution Explorer, which Visual 

Studio 2005 has created as part of your project: 

• Solution 'TextHello'  

This is the top-level solution file, of which there is one per application. If you use 
Windows Explorer to look at your \My Documents\Visual CSharp Step by 

Step\Chapter 1\TextHello folder, you'll see that the actual name of this file is 

TextHello.sln. Each solution file contains references to one or more project files. 

• TextHello  

This is the C# project file. Each project file references one or more files containing 
the source code and other items for the project. All the source code in a single 

project must be written in the same programming language. In Windows Explorer, 

this file is actually called TextHello.csproj, and it is stored in your \My 
Documents\Visual CSharp Step by Step\Chapter 1\TextHello\TextHello folder. 

• Properties  

This is a folder in the TextHello project. If you expand it, you will see that it 

contains a file called AssemblyInfo.cs. AssemblyInfo.cs is a special file that you 

can use to add attributes to a program, such as the name of the author, the date 
the program was written, and so on. There are additional attributes that you can 

use to modify the way in which the program will run. These attributes are outside 
the scope of this book. 

• References  

This is a folder that contains references to compiled code that your application can 
use. When code is compiled, it is converted into an assembly and given a unique 

name. Developers use assemblies to package up useful bits of code that they have 
written for distribution to other developers that might want to use them in their 

applications. Many of the features that you will be using when writing applications 
using this book will make use of assemblies provided by Microsoft with Visual 

Studio 2005. 

• Program.cs  

This is a C# source file, and is the one displayed in the Code and Text Editor 

window when the project is first created. You will write your code in this file. It 
contains some code that Visual Studio 2005 provides automatically, which you will 

examine shortly. 

Writing Your First Program 

The Program.cs file defines a class called Program that contains a method called Main. 

All methods must be defined inside a class. The Main method is special—it designates 
the program's entry point. It must be a static method. (Methods are discussed in 
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Chapter 3, “Writing Methods and Applying Scope.” Static methods are discussed in 

Chapter 7, “Creating and Managing Classes and Objects.” The Main method is discussed 
in Chapter 11, “Understanding Parameter Arrays.”) 

IMPORTANT 

C# is a case-sensitive language. You must spell Main with a capital M. 

In the following exercises, you'll write the code to display the message Hello World in 

the console; you'll build and run your Hello World console application; you'll learn how 
namespaces are used to partition code elements. 

Write the code using IntelliSense technology 

1. In the Code and Text Editor window displaying the Program.cs file, place the 
cursor in the Main method after the opening brace, and type Console. As you type 

the letter C at the start of the word Console an IntelliSense list appears. This list 
contains all of the valid C# keywords and data types that are valid in this context. 

You can either continue typing, or scroll through the list and double-click the 
Console item with the mouse. Alternatively, after you have typed Con, the 

Intellisense list will automatically home in on the Console item and you can press 
the Tab, Enter, or Spacebar key to select it. 

Main should look like this: 

static void Main(string[] args)  
{  
    Console  
} 

NOTE 
Console is a built-in class that contains the methods for displaying messages on 
the screen and getting input from the keyboard. 

2. Type a period immediately after Console. Another Intellisense list appears 
displaying the methods, properties, and fields of the Console class. 

3. Scroll down through the list until WriteLine is selected, and then press Enter. Alter-
natively, you can continue typing until WriteLine is selected and then press Enter. 

The IntelliSense list closes, and the WriteLine method is added to the source file. 

Main should now look like this: 

static void Main(string[] args)  
{  

    Console.WriteLine  
} 

4. Type an open parenthesis. Another IntelliSense tip appears. 

This tip displays the parameters of the WriteLine method. In fact, WriteLine is an 

overloaded method, meaning that Console contains more than one method named 
Write Line. Each version of the WriteLine method can be used to output different 
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types of data. (Overloaded methods are discussed in Chapter 3.) Main should now 

look like this: 

static void Main(string[] args)  
{  
    Console.WriteLine(  

} 

You can click the tip's up and down arrows to scroll through the overloaded 
versions of WriteLine. 

5. Type a close parenthesis, followed by a semicolon. 

Main should now look like this: 

static void Main(string[] args)  
{  
    Console.WriteLine();  
} 

6. Type the string "Hello World" between the left and right parentheses. 

Main should now look like this: 

static void Main(string[] args)  
{  
    Console.WriteLine("Hello World");  

} 

TIP 
Get into the habit of typing matched character pairs, such as ( and ) and { and }, 

before filling in their contents. It's easy to forget the closing character if you wait 
until after you've entered the contents. 
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NOTE 
You will frequently see lines of code containing two forward slashes followed by ordinary 

text. These are comments. They are ignored by the compiler, but are very useful for 
developers because they help document what a program is actually doing. For example: 

Console.ReadLine(); // Wait for the user to press the Enter key 

 

All text from the two slashes to the end of the line will be skipped by the compiler. You 
can also add multi-line comments starting with /*. The compiler will skip everything until 

it finds a */ sequence, which could be many lines lower down. You are actively 
encouraged to document your code with as many comments as necessary. 

Build and run the console application 

1. On the Build menu, click Build Solution. This action causes the C# code to be 

compiled, resulting in a program that you can run. The Output windows appears 
below the Code and Text Editor window. 

a. TIP 
If the Output window does not appear, click the View menu, and then click 

Output to display it. 
b. In the Output window, messages similar to the following show how the 

program is being compiled and display the details of any errors that have 
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occurred. In this case there should be no errors or warnings, and the 

program should build successfully: 
c. ------ Build started: Project: TextHello, Configuration: Debug Any CPU ----  
d. Csc.exe /config /nowarn:"1701;1702" /errorreport: prompt /warn:4 ... 

 
e. Compile complete –- 0 errors, 0 warnings 

 
f. TextHello -> C:\Documents and Settings\John\My Documents\Microsoft Press\...  

g. ============ Build: 1 succeeded or up-to-date, 0 failed, 0 skipped ======== 

h. NOTE 

An asterisk after the file name in the tab above the Code and Text Editor 
window indicates that the file has been changed since it was last saved. 

There is no need to manually save the file before building because the Build 
Solution command automatically saves the file. 

2. On the Debug menu, click Start Without Debugging. A Command window opens 
and the program runs. The message Hello World appears, and then the program 

waits for the user to press any key, as shown in the following graphic: 

 

3. Ensure that the Command window displaying the program has the focus, and then press Enter. The 

Command          window closes and you return to the Visual Studio 2005 programming 
environment.  

NOTE 
 If you run the program using Start Debugging on the Debug menu, the application runs 

but the Command window closes immediately without waiting for you to press a key. 

4. In the Solution Explorer, click the TextHello project (not the solution), and then 

click Show All Files   button. Entries named bin and obj appear above the C# 
source filenames. These entries correspond directly to folders named bin and obj 

in the project folder (\My Documents\Visual CSharp Step by Step\Chapter 
1\TextHello\TextHello). These folders are created when you build your application, 

and they contain the executable version of the program and some other files. 
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5. 5.In the Solution Explorer, click the + to the left of the bin entry. Another folder 

named Debug appears. 
6. 6.In the Solution Explorer, click the + to the left of the Debug entry. Three entries 

named TextHello.exe, TextHello.pdb, and TextHello.vshost.exe appear. The file 
TextHello.exe is the compiled program, and it is this file that runs when you click 

Start Without Debugging in the Debug menu. The other two files contain 
information that is used by Visual Studio 2005 if you run your program in Debug 

mode (when you click Start Debugging in the Debug menu). 

            

Command Line Compilation 

You can also compile your source files into an executable file manually by using the csc 
command-line C# compiler. You must first complete the following steps to set up your 

environment: 

1. On the Windows Start menu, point to All Programs, point to Microsoft Visual Studio 
2005, point to Visual Studio Tools, and click Visual Studio 2005 Command Prompt. 

A Command window opens, and the envionment variables PATH, LIB, and 
INCLUDE are configured to include the locations of the various .NET Framework 

libraries and utilities. 

TIP 

You can also run the vcvarsall.bat script, located in the C:\Program Files\Microsoft 
Visual Studio 8\VC folder, if you want to configure the environment variables while 

running in an ordinary Command Prompt window. 

2. In the Visual Studio 2005 Command Prompt window, type the following command 
to go to the \My Documents\Microsoft Press\Visual CSharp Step by Step\Chapter 

1\TextHello\TextHello project folder: 
3. cd \Documents and Settings\YourName\My Documents\Microsoft Press\Visual CSharp 

Step by Step\Chapter 1\TextHello\TextHello 

4. Type the following command: 

csc /out:TextHello.exe Program.cs 
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This command creates the executable file TextHello.exe from the C# source file. If 

you don't use the /out command-line option, the executable file takes its name 
from the source file and is called Program.exe. 

5. Run the program by typing the following command: 

TextHello 

The program should run exactly as before, except that you will not see the "Press 
any key to continue" prompt. 

Using Namespaces 

The example you have seen so far is a very small program. However, small programs 
can soon grow into bigger programs. As a program grows, it creates two problems. First, 
more code is harder to understand and maintain than less code. Second, more code 

usually means more names; more named data, more named methods, and more named 
classes. As the number of names increases so does the likelihood of the project build 

failing because two or more names clash (especially when the program uses third-party 

libraries). 

In the past, programmers tried to solve the name-clashing problem by prefixing names 
with some sort of qualifier (or set of qualifiers). This solution is not a good one because 

it's not scalable; names become longer and you spend less time writing software and 
more time typing (there is a difference) and reading and re-reading incomprehensibly 

long names. 

Namespaces help solve this problem by creating a named container for other identifiers, 

such as classes. Two classes with the same name will not be confused with each other if 
they live in different namespaces. You can create a class named Greeting inside the 

namespace named TextHello, like this: 

namespace TextHello  
{  
    class Greeting  

    {  
        ...  
    }  

} 

You can then refer to the Greeting class as TextHello.Greeting in your own programs. If 
someone else also creates a Greeting class in a different namespace and installs it on 

your computer, your programs will still work as expected because they are using the 
TextHello.Greeting class. If you want to refer the new Greeting class, you must specify 

that you want the class from the new namespace. 

It is good practice to define all your classes in namespaces, and the Visual Studio 2005 
environment follows this recommendation by using the name of your project as the top-

level namespace. The .NET Framework Software Developer Kit (SDK) also adheres to 
this recommendation; every class in the .NET Framework lives inside a namespace. For 
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example, the Console class lives inside the System namespace. This means that its fully 

qualified name is actually System.Console. 

Of course, if you had to write the fully qualified name of a class every time, it would be 
no better that just naming the class SystemConsole. Fortunately, you can solve this 

problem with a using directive. If you return to the TextHello program in Visual Studio 
2005 and look at the file Program.cs in the Code and Text Editor window, you will notice 

the following statements: 

using System;  
using System.Collections.Generic;  

using System.Text; 

The using statement brings a namespace into scope, and you no longer have to explictly 
qualify objects with the namespace they belong to in the code that follows. The three 

namespaces shown contain classes that are used so often that Visual Studio 2005 
automatically adds these using statements every time you create a new project. You can 

add further using directives to the top of a source file. 

The following exercise demonstrates the concept of namespaces further. 

Try longhand names 

1. In the Code And Text Editor window, comment out the using directive at the top of 
Program.cs: 

//using System; 

2. On the Build menu, click Build Solution. The build fails, and the Output pane 

displays the following error message twice (once for each use of the Console 
class): 

The name 'Console' does not exist in the current context. 

3. In the Output pane, double-click the error message. The identifier that caused the 
error is selected in the Program.cs source file. 

TIP 
The first error can affect the reliability of subsequent diagnostic messages. If your 

build has more than one diagnostic message, correct only the first one, ignore all 

the others, and then rebuild. This strategy works best if you keep your source files 
small and work iteratively, building frequently. 

4. In the Code and Text Editor window, edit the Main method to use the fully 

qualified name System.Console. 

Main should look like this: 

static void Main(string[] args)  
{  

    System.Console.WriteLine("Hello World"); 
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} 

NOTE 
When you type System., notice how the names of all the items in the System 
namespace are displayed by IntelliSense. 

5. On the Build menu, click Build Solution. The build succeeds this time. If it doesn't, 

make sure Main is exactly as it appears in the preceding code, and then try 

building again. 
6. Run the application to make sure it still works by clicking Start Without Debugging 

on the Debug menu. 

In the Solution Explorer, click the + to the left of the References entry. This displays the 
assemblies referenced by the Solution Explorer. An assembly is a library containing code 

written by other developers (such as the .NET Framework). In some cases, the classes 
in a namespace are stored in an assembly that has the same name (such as System), 

although this does not have to be the case—some assemblies hold more than one 
namespace. Whenever you use a namespace, you also need to make sure that you have 

referenced the assembly that contains the classes for that namespace; otherwise your 

program will not build (or run). 

Creating a Windows Forms Application 

So far you have used Visual Studio 2005 to create and run a basic Console application. 
The Visual Studio 2005 programming environment also contains everything you'll need 

to create graphical Windows applications. You can design the form-based user interface 

of a Windows application interactively by using the Visual Designer. Visual Studio 2005 
then generates the program statements to implement the user interface you've 

designed. 

From this explanation, it follows that Visual Studio 2005 allows you to maintain two 
views of the application: the Design View and the Code View. The Code and Text Editor 

window (showing the program statements) doubles as the Design View window (allowing 
you to lay out your user interface), and you can switch between the two views whenever 

you want. 

In the following set of exercises, you'll learn how to create a Windows program in Visual 

Studio 2005. This program will display a simple form containing a text box where you 
can enter your name and a button that, when clicked, displays a personalized greeting in 

a message box. You will use the Visual Designer to create your user interface by placing 
controls on a form; inspect the code generated by Visual Studio 2005; use the Visual 

Designer to change the control properties; use the Visual Designer to resize the form; 
write the code to respond to a button click; and run your first Windows program. 

Create a Windows project in Visual Studio 2005 

1. On the File menu, point to New, and then click Project. The New Project dialog box 
opens. 

2. In the Project Types pane, click Visual C#. 
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3. In the Templates pane, click the Windows Application icon. 

4. Ensure that the Location field refers to your \My Documents\Visual CSharp Step by 
Step\Chapter 1 folder. 

5. In the Name field, type WinFormHello. 
6. In the Solutions field, ensure that Create new Solution is selected. This action 

creates a new solution for holding the Windows application. The alternative, Add to 
Solution, will add the project to the TextHello solution. 

7. Click OK. Visual Studio 2005 closes your current application (prompting you to 
save it first of necessary) and creates and displays an empty Windows form in the 

Design View window. 

 

In the following exercise, you'll use the Visual Designer to add three controls to the 

Windows form and examine some of the C# code automatically generated by Visual 
Studio 2005 to implement these controls. 

Create the user interface 

1. Click the Toolbox tab that appears to the left of the form in the Design View. The 
Toolbox appears, partially obscuring the form and displaying the various 

components and controls that you can place on a Windows form. 
2. In the Toolbox, click the + sign by Common Controls to display a list of controls 

that are used by most Windows Forms applications. 
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3. Click Label, and then click the visible part of the form. A Label control is added to 

the form, and the Toolbox disappears from view. 

TIP 
If you want the Toolbox to remain visible but not hide any part of the form, click 

the Auto Hide button to the right in Toolbox title bar (it looks like a pin). The 
Toolbox appears permanently on the left side of the Visual Studio 2005 window, 

and the Design View shrinks to accommodate it. (You might lose a lot of space if 
you have a low-resolution screen.) Clicking the Auto Hide button once more 

causes the Toolbox to disappear again. 

4. The Label control on the form is probably not exactly where you want it. You can 

click and drag the controls you have added to a form to reposition them. Using this 
technique, move the Label control so that it is positioned towards the upper-left 

corner of the form. (The exact placement is not critical for this application.) 
5. On the View menu, click Properties Window. The Properties window appears on the 

right side of the screen. The Properties window allows you to set the properties for 
items in a project. It is context sensitive, in that it displays the properties for the 

currently selected item. If you click anywhere on the form displayed in the Design 
View, you will see that the Properties windows displays the properties for the form 

itself. If you click the Label control, the window displays the properties for the 
label instead. 

6. Click the Label control on the form. In the Properties window, locate the Text 

property, change it from label1 to Enter your name, and then press Enter. On the 
form, the label's text changes to Enter Your Name. 

TIP 

By default, the properties are displayed in categories. If you prefer to display the 
properties in alphabetical order, click the Alphabetical button that appears above 

the properties list. 

7. Display the Toolbox again. Click TextBox, and then click the form. A TextBox 

control is added to the form. Move the TextBox control so that it is directly 
underneath the Label control. 

TIP 

When you drag a control on a form, alignment handles appear automatically when 
the control becomes aligned vertically or horizontally with other controls. This give 

you a quick visual cue for making sure that controls are lined up neatly. 

8. While the TextBox control is selected, locate the Text property in the Properties 

window, type here, and then press Enter. On the form, the word here appears in 
the text box. 

9. In the Properties window, find the (Name) property. Visual Studio 2005 gives 
controls and forms default names, which, although they are a good starting point, 

are not always very meaningful. Change the name of the TextBox control to 
userName. 
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NOTE 

We will talk more about naming conventions for controls and variables in Chapter 
2, “Working with Variables, Operators, and Expressions.” 

10. Display the Toolbox again, click Button, and then click the form. Drag the 

Button control to the right of the TextBox control on the form so that it is aligned 
horizontally with the text box. 

11. Using the Properties window, change the Text property of the Button control 
to OK. Change its (Name) property to ok. The caption on the button changes. 

12. Click the Form1 form in the Design View window. Notice that resize handles 
(small squares) appear on the lower edge, the right-hand edge, and the right-

hand bottom corner of the form. 

13. Move the mouse pointer over the resize handle. The pointer changes to a 
diagonal double-headed arrow. 

14. Hold down the left mouse button, and drag the pointer to resize the form. 
Stop dragging and release the mouse button when the spacing around the controls 

is roughly equal. 

TIP 
You can resize many controls on a form by selecting the control and dragging one 

of the resize handles that appears in the corners of the control. Note that a form 
has only one resize handle, whereas most controls have four (one on each corner). 

On a form, any resize handles other than the one in the lower-right corner would 

be superfluous. Also note that some controls, such as Label controls, are 
automatically sized based on their contents and cannot be resized by dragging 

them. 

The form should now look similar to the one in the following graphic. 

            

1. In the Solution Explorer, right-click the file Form1.cs, and then click View Code. 
The Form1.cs source file appears in the Code and Text Editor window. 

There are now two tabs named Form1.cs above the Code and Text Editor/Design 

View window. You can click the one suffixed with [Design] to return to Design View 
window at any time. 

Form1.cs contains some of the code automatically generated by Visual Studio 
2005. You should note the following elements: 
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o using directives  

Visual Studio 2005 has written a number of using directives at the top of the 

source file (more than for the previous example). For example: 

using System.Windows.Forms; 

The additional namespaces contain the classes and controls used when 
building graphical applications—for example, the TextBox, Label, and Button 

classes. 

o The namespace  

Visual Studio 2005 has used the name of the project as the name of the top-

level namespace: 

namespace WinFormHello  
{  

    ...  
} 

o A class  

Visual Studio 2005 has written a class called Form1 inside the WinForm Hello 

namespace: 

namespace WinFormHello  
{  
    partial class Form1 ...  

    {  
        ...  
    }  
} 

NOTE 
For the time being, ignore the partial keyword in this class. I will describe its 
purpose shortly. 

This class implements the form you created in the Design View. (Classes are 
discussed in Chapter 7.) 

There does not appear to be much else in this class—there is a little bit of 

code known as a constructor that calls a method called InitializeComponent, 
but nothing else. (A constructor is a special method with the same name as 

the class. It is executed when the form is created and can contain code to 

initialize the form. Constructors are also discussed in Chapter 7.) However, 
Visual Studio 2005 is performing a sleight of hand and is hiding a few things 

from you, as I will now demonstrate. 

In a Windows Forms application, Visual Studio 2005 actually generates a 
potentially large amount of code. This code performs operations such as 
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creating and displaying the form when the application starts, and creating 

and positioning the various controls on the form. However, this code can 
change as you add controls to a form and change their properties. You are 

not expected to change this code (indeed, any changes you make are likely 
to be overwritten the next time you edit the form in the Design View), so 

Visual Studio 2005 hides it from you. 

To display the hidden code, return to the Solution Explorer, and click the 
Show All Files button. The bin and obj folders appear, much as they did with 

the Console application you developed in the first part of this chapter. 
However, notice that Form1.cs now has a + sign next to it. If you click this 

+ sign, you see a file called Form1.Designer.cs, and a file called Form1.resx. 

Double-click the file Form1.Designer.cs to display its contents in the Code 

and Text Editor window. You will see the remaining code for the Form1 class 
in this file. C# allows you to split the code for a class across multiple source 

files, as long as each part of the class is marked with the partial keyword. 
This file includes a region labelled Windows Form Designer generated code. 

Expanding this region by clicking the + sign reveals the code created and 
maintained by Visual Studio 2005 when you edit a form using the Design 

View window. The actual contents of this file include: 

o The InitializeComponent method  

This method is mentioned in the file Form1.cs. The statements inside this 

method set the properties of the controls you added to the form in the 
Design View. (Methods are discussed in Chapter 3.) Some of the statements 

in this method that correspond to the actions you performed using the 
Properties window are shown below: 

...  
private void InitializeComponent()    
{  
   this.label1 = new System.Windows.Forms.Label();  

   this.userName = new System.Windows.Forms.TextBox();  
   this.ok = new System.Windows.Forms.Button();  
   ...  

   this.label1.Text = "Enter your name";  
   ...  
   this.userName.Text = "here";  
   ...  

   this.ok.Text = "OK";  
   ...  
}  

... 

o Three fields  

Visual Studio 2005 has created three fields inside the Form1 class. These 
fields appear near the end of the file: 

private System.Windows.Forms.Label label1;  
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private System.Windows.Forms.TextBox userName;  
private System.Windows.Forms.Button ok;  

... 

These fields implement the three controls you added to the form in Design 
View. (Fields are discussed in Chapter 7.) 

It is worth restating that although this file is interesting to look at, you should never edit 

its contents yourself. Visual Studio 2005 automatically updates this file when you make 
changes in the Design View. Any code that you need to write yourself should be placed 

in the Form1.cs file. 

At this point you might well be wondering where the Main method is and how the form 

gets displayed when the application runs; remember that Main defines the point at 
which the program starts. In the Solution Explorer, you should notice another source file 

called Program.cs. If you double-click this file the following code appears in the Code 
and Text Editor window: 

namespace WinFormHello  

{  
    static class Program  
    {  
        /// <summary>  

        /// The main entry point for the application.  
        /// </summary>  
        [STAThread]  

        static void Main()  
        {  
            Application.EnableVisualStyles();  
            Application.Run(new Form1());  

        }  
    }  
} 

You can ignore most of this code. However, the key statement is: 

Application.Run(new Form1()); 

This statement creates the form and displays it, whereupon the form takes over. 

In the following exercise, you'll learn how to add code that runs when the OK button on 
the form is clicked. 

Write the code for the OK button 

1. Click the Form1.cs[Design] tab above the Code and Text Editor window to display 
Form1 in the Design View. 

2. Move the mouse pointer over the OK button on the form, and then double-click the 
button. The Form1.cs source file appears in the Code and Text Editor window. 

Visual Studio 2005 has added a method called ok_Click to the Form1 class. (It has 
also added a statement to the InitializeComponent method in the 

Form1.Designer.cs file to automatically call ok_Click when the OK button is 
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clicked. It does this by using a delegate type; delegates are discussed in Chapter 

16, “Delegates and Events.”) 
3. Type the MessageBox statement shown below inside the ok_Click method. The 

complete method should look like this: 
4. private void ok_Click(object sender, System.EventArgs e)  
5. {  

6.     MessageBox.Show("Hello " + userName.Text);  
} 

Make sure you have typed this code exactly as shown, including the trailing 
semicolon. 

You're now ready to run your first Windows program. 

Run the Windows program 

1. On the Debug menu, click Start Without Debugging. Visual Studio 2005 saves your 

work, compiles your program, and runs it. The Windows form appears: 
2. Enter your name, and then click OK. A message box appears welcoming you by 

name. 

 

3. Click OK in the message box. The message box closes. 
4. In the Form1 window, click the Close button (the X in the upper-right corner of the 

form). The Form1 window closes. 

• If you want to continue to the next chapter 

Keep Visual Studio 2005 running, and turn to Chapter 2. 

• If you want to exit Visual Studio 2005 now 

On the File menu, click Exit. If you see a Save dialog box, click Yes to save 
your work. 

Chapter 1 Quick Reference 

TO                                      Do this                                                                                KeyCombination 
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Chapter 2 
Working with Variables, Operators, and Expressions 
After completing this chapter, you will be able to: 

• Understand statements, identifiers, and keywords. 
• Use variables to store information. 

• Work with primitive data types. 
• Use arithmetic operators such as the plus sign (+) and the minus sign (–). 

• Increment and decrement variables. 

In Chapter 1, “Welcome to C#,” you learned how to use the Microsoft Visual Studio 2005 

programming environment to build and run a console program and a Windows Forms 
application. In this chapter, you'll be introduced to the elements of Microsoft Visual C# 

syntax and semantics, including statements, keywords, and identifiers. You'll study the 
primitive types that are built into the C# language and the characteristics of the values 

that each type holds. You'll also see how to declare and use local variables (variables 
that exist only within a function or other small section of code), learn about the 

arithmetic operators that C# provides, learn how to use operators to manipulate values, 
and learn how to control expressions containing two or more operators. 

Understanding Statements 

A statement is a command that performs an action. Statements are found inside 

methods. You'll learn more about methods in Chapter 3, “Writing Methods and Applying 
Scope,” but for now, think of a method as a named sequence of statements inside a 

class. Main, which was introduced in the previous chapter, is an example of a method. 
Statements in C# must follow a well-defined set of rules. These rules are collectively 

known as syntax. (In contrast, the specification of what statements do is collectively 
known as semantics.) One of the simplest and most important C# syntax rules states 

Create a new 
console 

application 

 

Create a new 

Windows 
application 

 

Build the 
application 

 

On the File menu, point to New, and then click Project 
to open the New Project dialog box. For the project 

type, select Visual C#. For the template, select Console 
Application. Select a directory for the project files in the 

Location box. Choose a name for the project. Click OK. 

On the File menu, point to New, and then click Project 

to open the New Project dialog box. For the project 
type, select Visual C#. For the template, select 

Windows Application. Select a directory for the project 
files in the location box. Choose a name for the project. 

Click OK. 

On the Build menu, click Build Solution. 

 

 

 

 

 

 

 

F6 

 

Ctrl+F5 
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that you must terminate all statements with a semicolon. For example, without its 

terminating semicolon, the following statement won't compile: 

Console.WriteLine("Hello World"); 

TIP 

C# is a “free format” language, which means that white space, such as a space 
character or a new line, is not significant except as a separator. In other words, you are 

free to lay out your statements in any style you choose. A simple, consistent layout style 
makes a program easier to read and understand. 

The trick to programming well in any language is learning its syntax and semantics and 
then using the language in a natural and idiomatic way. This approach makes your 
programs readable and easy to modify. In the chapters throughout this book, you'll see 

examples of the most important C# statements. 

Using Identifiers 

Identifiers are the names you use to identify the elements in your programs. In C#, you 
must adhere to the following syntax rules when choosing identifiers: 

• You can use only letters (uppercase and lowercase), digits, and underscore 

characters. 
• An identifier must start with a letter (an underscore is considered a letter). 

For example, result, _score, footballTeam, and plan9 are all valid identifiers, whereas 
result%, footballTeam$, and 9plan are not. 

IMPORTANT 

C# is a case-sensitive language: footballTeam and FootballTeam are not the same 
identifier. 

 
Identifying Keywords 

The C# language reserves 77 identifiers for its own use, and you should not reuse these 
identifiers for your own purposes. These identifiers are called keywords, and each has a 

particular meaning. Examples of keywords are class, namespace, and using. You'll learn 
the meaning of most of the keywords as you proceed through this book. The keywords 

are listed in the following table. 

abstract as base bool 

break byte case catch 

char checked class const 

continue decimal default delegate 

do double else enum 

event explicit extern false 

finally fixed float for 

foreach goto if implicit 

in int interface internal 

is lock long namespace 
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new null object operator 

out override params private 

protected public readonly ref 

return sbyte sealed short 

sizeof stackalloc static string 

struct switch this throw 

true try typeof uint 

ulong unchecked unsafe ushort 

using virtual void volatile 

while    

 

TIP 
In the Visual Studio 2005 Code and Text Editor window, keywords are colored blue when 

you type them. 
 

TIP 
In the Visual Studio 2005 Code and Text Editor window, keywords are colored blue when 

you type them. 
Using Variables 

A variable is a storage location that holds a value. You can think of a variable as a box 
holding temporary information. You must give each variable in a program a unique 

name. You use a variable's name to refer to the value it holds. For example, if you want 
to store the value of the cost of an item in a store, you might create a variable simply 

called cost, and store the item's cost in this variable. Later on, if you refer to the cost 
variable, the value retrieved will be the item's cost that you put there earlier. 

Naming Variables 

You should adopt a naming convention for variables that help you avoid confusion 
concerning the variables you have defined. The following list contains some general 

recommendations: 

• Don't use underscores. 

• Don't create identifiers that differ only by case. For example, do not create one 
variable named myVariable and another named MyVariable for use at the same 

time, because it is too easy to get them confused. 

NOTE 

Using identifiers that differ only by case can limit the ability to reuse classes in 
applications developed using other languages that are not case sensitive, such as 

Visual Basic. 

• Start the name with a lowercase letter. 
• In a multiword identifier, start the second and each subsequent word with an 

uppercase letter. (This is called camelCase notation.) 
• Don't use Hungarian notation. (Microsoft Visual C++ developers reading this book 

are probably familiar with Hungarian notation. If you don't know what Hungarian 
notation is, don't worry about it!) 
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IMPORTANT 

You should treat the first two recommendations as compulsory because they relate 
to Common Language Specification (CLS) compliance. If you want to write 

programs that can interoperate with other languages, such as Microsoft Visual 
Basic .NET, you need to comply with these recommendations. 

For example, score, footballTeam, _score, and FootballTeam are all valid variable 

names, but only the first two are recommended. 

Declaring Variables 

Remember that variables are like boxes in memory that can hold a value. C# has many 
different types of values that it can store and process—integers, floating-point numbers, 
and strings of characters, to name three. When you declare a variable, you must specify 

what type of data it will hold. 

NOTE 

Microsoft Visual Basic programmers should note that C# does not allow implicit 
declarations. You must explicitly declare all variables before you can use them if you 

want your code to compile. 

You declare the type and name of a variable in a declaration statement. For example, 
the following statement declares that the variable named age holds int (integer) values. 

As always, the statement must be terminated with a semi-colon. 

int age; 

The variable type int is the name of one of the primitive C# types—integer which is a 

whole number. (You'll learn about several primitive data types later in this chapter.) 
After you've declared your variable, you can assign it a value. The following statement 

assigns age the value 42. Again, you'll see that the semicolon is required. 

age = 42; 

The equal sign (=) is the assignment operator, which assigns the value on its right to 
the variable on its left. After this assignment, the age variable can be used in your code 

to refer to the value it holds. The next statement writes the value of the age variable, 
42, to the console: 

Console.WriteLine(age); 

TIP 
If you leave the mouse pointer over a variable in the Visual Studio 2005 Code and Text 

Editor window, a ToolTip appears telling you the type of the variable. 
Working with Primitive Data Types 

C# has a number of built-in types called primitive data types. The following table lists 
the most commonly used primitive data types in C#, and the ranges of values that you 

can store in them. 
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Data 

type 

Description Size (bits) *Range Sample 

usage 

int Whole numbers 32 <–>231 through 
231<–>1 

int count;  
count = 42; 

long Whole numbers (bigger range) 64 <–>263 through 
263<–>1 

long wait;  
wait = 42L; 

float Floating-point numbers 32 ±3.4 × 1038 float away; 
away = 

0.42F; 

double Double precision (more 

accurate) floating-point 
numbers 

64 ±1.7 × 10308 double 
trouble; 

trouble = 
0.42; 

decimal Monetary values 128 28 significant 

figures 

decimal 

coin;  
coin = 
0.42M; 

string Sequence of characters 16 bits per 
character 

Not applicable string vest;  
vest = 
"42"; 

char Single character 16 0 through 216 
<–>1 

char grill;  
grill = '4'; 

bool Boolean 8 true or false bool teeth;  
teeth = 
false; 

*The value of 216 is 32,768; the value of 231 is 2,147,483,648; and the value of 263 is 
9,223,372,036,854,775,808. 

 

Unassigned Local Variables 

When you declare a variable, it contains a random value until you assign a value to it. 

This behavior was a rich source of bugs in C and C++ programs that created a variable 
and used it as a source of information before giving it a value. C# does not allow you to 

use an unassigned variable. You must assign a value to a variable before you can use it, 
otherwise your program will not compile. This requirement is called the Definite 

Assignment Rule. For example, the following statements will generate a compile-time 
error because age is unassigned: 

int age;  

Console.WriteLine(age); // compile time error 

 

Displaying Primitive Data Type Values 

In the following exercise, you'll use a C# program named PrimitiveDataTypes to 

demonstrate how several primitive data types work. 

Display primitive data type values 
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1. Start Visual Studio 2005. 

2. On the File menu, point to Open, and then click Project/Solution. 

The Open Project dialog box appears. 

3. Move to the \Microsoft Press\Visual CSharp Step by Step\Chapter 
2\PrimitiveDataTypes folder in your My Documents folder. Select the file 

PrimitiveDataTypes.sln and then click Open. 

The solution loads, and the Solution Explorer displays the solution and 

PrimitiveDataTypes project. 

NOTE 
Solution file names have the .sln suffix, such as PrimitiveDataTypes.sln. A solution 

can contain one or more projects. Project files have the .csproj suffix. If you open 

a project rather than a solution, Visual Studio 2005 will automatically create a new 
solution file for it. If you build the solution, Visual Studio 2005 automatically saves 

any updated or new files, and you will be prompted to provide a name and location 
for the new solution file. 

4. On the Debug menu, click Start Without Debugging. 

The following application window appears: 

            

 

5. In the Choose A Data type list, click the string type. 

The value 42 appears in the Sample value box. 

6. Click the int type in the list. 

The value to do appears in the Sample value box, indicating that the statements to 

display an int value still need to be written. 
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7. Click each data type in the list. Confirm that the code for the double and bool 

types also needs to be completed. 
8. Click Quit closing the window and stopping the program. 

Control returns to the Visual Studio 2005 programming environment. 

Use primitive data types in code 

1. Right-click the Form1.cs file in the Solution Explorer and then click View Code. 

The Code and Text Editor window opens displaying the Form1.cs file. 

2. In the Code and Text Editor window, find the show Float Value method listed here: 

   private void showFloatValue()  

   {  
    float var;  
    var = 0.42F;  
    value.Text = "0.42F";  

 } 

TIP 
To locate an item in your project, point to Find And Replace on the Edit menu and 

click Quick Find. A dialog box opens asking what you want to search for. Type the 
name of the item you're looking for, and then click Find Next. By default, the 

search is not case-sensitive. If you want to perform a case-sensitive search, click 
the + button next to the Find Options label to display additional options, and check 

the Match Case check box. If you have time, you can experiment with the other 
options as well. 

 
You can also press Ctrl+F (press the Control key, and then press F) to display the 

Quick Find dialog box rather then usin 

g the Edit menu. Similarly, you can press Ctrl+H to display the Quick Find and 

Replace dialog box. 

The showFloatValue method runs when you click the float type in the list box. This 
method contains three statements: 

The first statement declares a variable named var of type float. 

The second statement assigns var the value 0.42F. (The F is a type suffix 
specifying that 0.42 should be treated as a float value. If you forget the F, the 

value 0.42 will be treated as a double, and your program will not compile 
because you cannot assign a value of one type to a variable of a different type 

in this way.) 

The third statement displays the value of this variable in the value TextBox on 

the form. This statement requires a little bit of your attention. The way in which 
you display an item in a TextBox is to set its Text property. You did this at 
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design time in Chapter 1 using the Properties window. This statement shows 

you how to perform the same task programmatically, using the expression 
value.Text. The data that you put in the Text property must be a string (a 

sequence of characters), and not a number. If you try and assign a number to 
the Text property your program will not compile. For this reason, the statement 

simply displays the text “0.42F” in the TextBox (anything in double-quotes is 
text, otherwise known as a string). In a real-world application, you would add 

statements that convert the value of the variable var into a string and then put 
this into the Text property, but you need to know a little bit more about C# and 

the .NET Framework before we can do that (we will cover data type conversions 
in Chapter 11, “Understanding Parameter Arrays,” and Chapter 19, “Operator 

Overloading”). 

3. In the Code and Text Editor window, locate the showIntValue method listed here: 

private void showIntValue()  

{  
    value.Text = "to do";  

} 
 

The showIntValue method is called when you click the int type in the list box. 

TIP 
Another way to find a method in the Code and Text Editor window is to click the 

Members list that appears above the window, to the right. This window displays a 
list of all the methods (and other items). You can click the name of a member, and 

you will be taken directly to it in the Code and Text Editor window. 

4. Type the following two statements at the start of the showIntValue method, after the open curly 
brace: 

   int var;  
var = 42; 

The showIntValue method should now look like this: 

private void showIntValue()  

{  
    int var;  
    var = 42;  
    value.Text = "to do";  

} 
 

5. On the Build menu, click Build Solution. 
a. The build will display some warnings, but no errors. You can ignore the 

warnings for now. 

6. In the original statement, change the string “to do” to “42”. 

b. The method should now look exactly like this: 
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c. private void showIntValue()  
d. {  

i. int var;  
ii. var = 42;  
iii. value.Text = "42";  

e. } 

7. On the Debug menu, click Start Without Debugging. 

f. The form appears again. 
g. TIP 

If you have edited the source code since the last build, the Start Without 
Debugging command automatically rebuilds the program before starting the 

application. 

8. Select the int type in the list box. Confirm that the value 42 is displayed in the 
Sample value text box. 

9. Click Quit to close the window and stop the program. 
10. In the Code and Text Editor window, find the showDoubleValue method. 

11. Edit the showDoubleValue method exactly as follows: 

   private void showDoubleValue()  
   {  

    double var;  
    var = 0.42;  
    value.Text = "0.42";  

} 

12. In the Code and Text Editor window, locate the showBoolValue method. 

13. Edit the showBoolValue method exactly as follows: 

      private void showBoolValue()  
   {  
    bool var;  

    var = false;  
    value.Text = "false"; } 

14. On the Debug menu, click Start Without Debugging. 

The form appears. 

15. In the list, select the int, double, and bool types. In each case, verify that 

the correct value is displayed in the Sample value text box. 
16. Click Quit to stop the program. 

Using Arithmetic Operators 

C# supports the regular arithmetic operations you learned in your childhood: the plus 

sign (+) for addition, the minus sign (–) for subtraction, the asterisk (*) for 
multiplication, and the forward slash (/) for division. These symbols (+, –, *, and /) are 

called operators as they “operate” on values to create new values. In the following 
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example, the variable moneyPaidToConsultant ends up holding the product of 750 (the 

daily rate) and 20 (the number of days the consultant was employed): 

long moneyPaidToConsultant;  
moneyPaidToConsultant = 750 * 20; 

NOTE 

The values that an operator operates on are called operands. In the expression 750 * 
20, the * is the operator, and 750 and 20 are the operands. 

Determining an Operator's Values 

Not all operators are applicable to all data types, so whether you can use an operator on 

a value depends on the value's type. For example, you can use all the arithmetic 
operators on values of type char, int, long, float, double, or decimal. However, with one 

exception, you can't use the arithmetic operators on values of type string or bool. So the 
following statement is not allowed because the string type does not support the minus 

operator (subtracting one string from another would be meaningless): 

// compile time error  
Console.WriteLine("Gillingham" – "Manchester City"); 

The exception is that the + operator can be used to concatenate string values. The 
following statement writes 431 (not 44) to the console: 

Console.WriteLine("43" + "1"); 

TIP 

You can use the method Int32.Parse to convert a string value to an integer if you need 
to perform arithmetic computations on values held as strings. 

You should also be aware that the type of the result of an arithmetic operation depends 
on the type of the operands used. For example, the value of the expression 5.0 / 2.0 is 

2.5; the type of both operands is double (in C#, literal numbers with decimal points are 
always double, not float, in order to maintain as much accuracy as possible), and so the 

type of the result is also double. However, the value of the expression 5 / 2 is 2. In this 
case, the type of both operands is int, and so the type of the result is also int. C# 

always rounds values down in circumstances like this. The situation gets a little more 
complicated if you mix the types of the operands. For example, the expression 5 / 2.0 

consists of an int and a double. The C# compiler detects the mismatch and generates 
code that converts the int into a double before performing the operation. The result of 

the operation is therefore a double (2.5). However, although this works, it is considered 
poor practice to mix types in this way. 

C# also supports one less-familiar arithmetic operator: the remainder, or modulus, 
operator, which is represented by the percent symbol (%). The result of x % y is the 

remainder after dividing x by y. For example, 9 % 2 is 1 since 9 divided by 2 is 8, 
remainder 1. 

NOTE 

In C and C++, you can't use the % operator on floating-point values, but you can use it 
in C#. 

Examining Arithmetic Operators 
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The following exercise demonstrates how to use the arithmetic operators on int values 

using a previously written C# program named MathsOperators. 

Work with arithmetic operators 

1. On the File menu, point to Open, and then click Project/Solution. Open the 
MathsOperators project, located in the \Microsoft Press\Visual CSharp Step by 

Step\Chapter 2\MathsOperators folder in your My Documents folder. 

2. On the Debug menu, click Start Without Debugging. 

A form appears on the screen. 

3. Type 54 in the left operand text box. 
4. Type 13 in the right operand text box. 

You can now apply any of the operators to the values in the text boxes. 

5. Click the – Subtraction option, and then click Calculate. 

The text in the Expression box changes to 54 – 13, and 41 appears in the Result 

box, as shown in the following graphic: 

 

 

 

6. Click the / Division option, and then click Calculate. 

The text in the Expression text box changes to 54 / 13, and the number 4 appears 

in the Result box. In real life, 54 / 13 is 4.153846 recurring, but this is not real 
life; this is C#! In C#, when you divide one integer by another integer, the answer 

you get back is an integer, as explained earlier. 
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7. Select the % Remainder option, and then click Calculate. 

The text in the Expression text box changes to 54 % 13, and the number 2 

appears in the Result box. This is because the remainder after dividing 54 by 13 is 
2 (54 – ((54 / 13) * 13) is 2 if you do the arithmetic rounding down to an integer 

at each stage—my old maths master at school would be horrified to be told that 
(54 / 13) * 13 does not equal 54!). 

8. Practice with other combinations of numbers and operators. When you're finished, 
click Quit. 

The program stops, and you return to the Visual Studio 2005 programming 

environment. 

Now take a look at the MathsOperators program code. 

Examine the MathsOperators program code 

1. Display the Form1 form in the Design View window (click the Form1.cs[Design] tab 
if necessary). 

TIP 

You can quickly switch between the Design View window and the Code and Text 
Editor displaying the code for a form by pressing the F7 key. 

2. In the View menu, point to Other Windows and then click Document Outline. 

The Document Outline window appears showing the names and types of the 
controls on the form. If you click each of the controls on the form, the name of the 

control is highlighted in the Document Outline window. 
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IMPORTANT 

Be careful not to accidentally delete or change the names of any controls on the 
form while viewing them in the Document Outline window. The application will no 

longer work if you do. 

3. Click the the two TextBox controls that the user types numbers into on the form. 
In the Document Outline window, verify that they are named lhsOperand and 

rhsOperand. 

When the form runs, the Text property of each of these controls holds (as strings) 

the numeric values you enter. 

4. Towards the bottom of the form, verify that the TextBox control used to display 
the expression being evaluated is named expression, and that the TextBox control 

used to display the result of the calculation is named result. 

At runtime, setting the Text property of a TextBox control to a string value causes 

that value to be displayed. 

5. Close the Document Outline window. 
6. Press F7 to display the Form1.cs source file in the Code and Text Editor window. 

7. In the Code and Text Editor window, locate the subtractValues method: 

   private void subtractValues()  
   {  

    int lhs = int.Parse(lhsOperand.Text);  
    int rhs = int.Parse(rhsOperand.Text);  
    int outcome;  
    outcome = lhs – rhs;  

    expression.Text = lhsOperand.Text + " – " + rhsOperand.Text;  
    result.Text = outcome.ToString();  

} 

The first statement in this method declares an int variable called lhs and initializes it to 
the result of the explicit conversion of the lhsOperand.Text property to an int. (The Text 
property of a TextBox is a string, and must be converted to an integer before you can 

store it in an int. This is what the int.Parse method does) The second statement declares 
an int variable called rhs and initializes it to the result of the explicit conversion of the 

rhsOperand.Text property to an int. The third statement declares an int variable called 
outcome. The fourth statement subtracts the value of the rhs variable from the value of 

the lhs variable, and the result is assigned to outcome. The fifth statement concatenates 
three strings (using the + operator) and assigns the result to the expression.Text 

property. The sixth statement converts the int value of outcome to a string by using the 

ToString method, and assigns the string to the result.Text property. 



SREEKANTH                                                                                                                                                                  C# STEP BY STEP 

35 

 

The Text Property and the ToString Method 

Controlling Precedence 

Precedence governs the order in which an expression's operators are evaluated. 
Consider the following expression, which uses the + and * operators: 

2 + 3 * 4 

This expression is potentially ambiguous; does 3 bind to the + operator on its left or to 
the * operator on its right? The order of the operations matters because it changes the 

result: 

• If the + operator takes precedence over the * operator, 3 binds to the + operator, 
the result of the addition (2 + 3) forms the left operand of the * operator, and the 

result of the whole expression is 5 * 4, which is 20. 
• If the * operator takes precedence over the + operator, 3 binds to the * operator, 

the result of the multiplication (3 * 4) forms the right operand of the + operator, 

and the result of the whole expression is 2 + 12, which is 14. 

In C#, the multiplicative operators (*, /, and %) have precedence over the additive 
operators (+ and –). The answer to 2 + 3 * 4 is therefore 14. As each new operator is 

discussed in later chapters, its precedence will be explained. 

You can use parentheses to override precedence and force operands to bind to operators 

in a different way. For example, in the following expression, the parentheses force the 2 
and the 3 to bind to the + operator (making 5), and the result of this addition forms the 

left operand of the * operator to produce the value 20: 

(2 + 3) * 4 

NOTE 

The term parentheses or round brackets refers to ( ). The term braces or curly brackets 
refers to { }. The term square brackets refers to [ ]. 

Using Associativity to Evaluate Expressions 

Operator precedence is only half the story. What happens when an expression contains 
different operators that have the same precedence? This is where associativity becomes 

I mentioned earlier that TextBox controls displayed on a form have a Text property that 

allows you to access the displayed contents. For example, the expression result.Text 
refers to the contents of the result text box on the form. Text boxes also have many 

other properties, such as the location and size of the text box on the form. You will 

learn more about properties in Chapter 14, “Implementing Properties to Access 
Attributes.” 

Every class has a ToString method. The purpose of ToString is to convert an object into 

its string representation. In the previous example, the ToString method of the integer 
object, outcome, is used to convert the integer value of outcome into the equivalent 

string value. This conversion is necessary because the value is displayed in the Text 
property of the result field—the Text property can only contain strings. When you 
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important. Associativity is the direction (left or right) to which an expression's operators 

are bound. Consider the following expression that uses the / and the * operators: 

4 / 2 * 6 

This expression is still potentially ambiguous. Does 2 bind to the / operator to its left or 
to the * operator to its right? The precedence of both operators is the same (they are 

both multiplicative), but the order in which the expression is evaluated is important 
because you get one of two possible results: 

• If the 2 binds to the / operator, the result of the division (4 / 2) forms the left 

hand operand of the * operator, and the result of the whole expression is (4 / 2) * 

6, or 12. 
• If the 2 binds to the * operator, the result of the multiplication (2 * 6) forms the 

right hand operand of the / operator and the result of the whole expression is 4 / 
(2 * 6), or 4/12. 

Because the * and / operators have the same precedence, you cannot use precedence to 

determine whether the 2 binds to the * operator or to the / operator. However, 
operators also have associativity to determine how they are evaluated. The * and / 

operators are both left-associative, which means that the operands are evaluated from 
left to right. In this case, 4 / 2 will be evaluated before multiplying by 6, giving the 

result 12. As each new operator is discussed in later chapters, its associativity will also 

be covered. 

Incrementing and Decrementing Variables 

If you wanted to add 1 to a variable, you could use the + operator: 

count = count + 1; 

However, it is unlikely that an experienced programmer would write code like this. 

Adding 1 to a variable is so common that in C#, you can do it with the ++ operator. To 
increment the variable count by 1, write the following statement: 

count++; 

Similarly, subtracting 1 from a variable is so common that in C# you can do it with the –
– operator. To decrement the variable count by one, write this statement: 

count--; 

NOTE 

The ++ and – – operators are unary operators, meaning that they take only a single 
operand. Theyshare the same precedence and left associativity as the ! unary operator, 

which is discussed in Chapter 4, “Using Decision Statements.” 

The following table shows you how to use these two operators. 

Don't write this Write this 

variable = variable + 1; variable++; 
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variable = variable - 1; variable--; 

 

Prefix and Postfix 

• If you want to continue to the next chapter 

            Keep Visual Studio 2005 running, and turn to Chapter 3. 

• If you want to exit Visual Studio 2005 now 

            On the File menu, click Exit. If you see a Save dialog box, click Yes to 
save your work. 

 

The increment (++) and decrement (––) operators are unusual in that you can place 
them either before or after the variable. Using the operator symbol before the variable 

is called the prefix form of the operator, and using the operator symbol after the 
variable is called the postfix form. Here are examples: 

count++; // postfix increment  
++count; // prefix increment  
count--; // postfix decrement  
--count; // prefix decrement 

Whether you use the prefix or postfix form of the ++ or –– operator makes no 
difference to the variable being incremented or decremented. For example, if you 
write count++, the value of count increases by 1, and if you write ++count, the value 

of count also increases by 1. Knowing this, you're probably wondering why there are 
two ways to write the same thing. To understand the answer, you must remember 

that ++ and –– are operators, and that all operators produce a value. The value 

produced by count++ is the value of count before the increment takes place, whereas 
the value produced by ++count is the value of count after the increment takes place. 

Here is an example: 

int x;  
x = 42;  
Console.WriteLine(x++); // x is now 43, 42 written out  

The way to remember which operand does what is to look at the order of the 
elements (the operand and the operator) in a prefix or postfix expression. In the 

expression x++, the variable x occurs first, so its value is used as the value of the 
expression before x is incremented. In the expression ++x, the operator occurs first, 

so it is performed before the the value of x is evaluated as the result. 

These operators are most commonly used in while and do statements, which will be 
presented in Chapter 5, “Using Compound Assignment and Iteration Statements.” If 

you are using the increment and decrement operators in isolation, stick to the postfix 

form and be consistent. 
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Chapter 2 Quick Reference 
 
 
To Do this 

Declare a variable Write the name of the data type, followed by the name of the 
variable, followed by a semicolon. For example: 

int outcome; 

Change the value 
of a variable 

Write the name of the variable on the left, followed by the 
assignment operator, followed by the expression calculating the 

new value, followed by a semicolon. For example: 

outcome = 42; 

Convert a string 
to an int 

Call the System.Int32.Parse method. For example: 

System.Int32.Parse("42"); 

Override 
precedence 

Use parentheses in the expression to force operands to bind to 
specific operators. For example: 

(3 + 4) * 5 

Increment or 
decrement a 

variable 

Use the ++ or <;$MI><;$MI> operator. For example: 

count++; 

 

Chapter 3 

Writing Methods and Applying Scope 
 

After completing this chapter, you will be able to: 

• Declare and call methods. 
• Pass information to a method. 
• Return information from a method. 

• Define local and class scope. 
• Use the integrated debugger to step in and out of methods as they run. 

In Chapter 2, “Working with Variables, Operators, and Expressions,” you learned how to 
declare variables, how to create expressions using operators, and how precedence and 

associativity control expressions containing multiple operators. In this chapter, you'll 
learn about methods. You'll also learn how to use arguments and parameters to pass 

information to a method and how to return information from a method by using return 
statements. Finally, you'll see how to step in and out of methods by using the Microsoft 

Visual Studio 2005 integrated debugger. This information is useful when you need to 
trace the execution of your methods because they do not work quite as you expected. 

Declaring Methods 

A method is a named sequence of statements. If you have previously programmed using 
languages such as C or Visual Basic, a method is very similar to a function or a 
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subroutine. Each method has a name and a body. The method name should be a 

meaningful identifier that indicates the overall purpose of the method 
(CalculateIncomeTax, for example). The method body contains the actual statements to 

be run when the method is called. Most methods can be given some data for processing 
and can return information, which is usually the result of the processing. Methods are a 

fundamental and powerful mechanism. 

Specifying the Method Declaration Syntax 

The syntax of a Microsoft Visual C# method is as follows: 

returnType methodName ( parameterList )   

{   
    // method body statements go here   
} 

• The returnType is the name of a type and specifies what kind of information the 

method returns. This can be the name of any type, such as int or string. If you're 
writing a method that does not return a value, you must use the keyword void in 

place of the return type. 
• The methodName is the name used to call the method. Method names must follow 

the same identifier rules as variable names. For example, addValues is a valid 
method name, whereas add$Values is not valid. For now, you should use 

camelCase for method names, and you should start them with a verb to make 
them descriptive—for example, displayCustomer. 

• The parameterList is optional and describes the types and names of the 
information that you can pass into the method. You write the parameters between 

the left and right parentheses as though you're declaring variables, with the name 
of the type followed by the name of the parameter. If the method you're writing 

has two or more parameters, you must separate them with commas. 

• The method body statements are the lines of code that are run when the method 
is called. They are enclosed between opening and closing curly braces ({ }). 

IMPORTANT 

C, C++, and Microsoft Visual Basic programmers should note that C# does not support 
global methods. You must write all your methods inside a class, or your code will not 

compile. 

Here's the definition of a method called addValues that returns an int result and has two 

int parameters called leftHandSide and rightHandSide: 

int addValues(int leftHandSide, int rightHandSide)   
{   
    // ...  

    // method body statements go here   
    // ...  
} 

Here's the definition of a method called showResult that does not return a value and has 

a single int parameter called answer: 
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void showResult(int answer)  
{  

    // ...  
} 

Notice the use of the keyword void to indicate that the method does not return anything. 

IMPORTANT 

Visual Basic programmers should notice that C# does not use different keywords to 
distinguish between a method that returns a value (a function) and a method that does 

not return a value (a procedure or subroutine). You must always specify either a return 
type or void. 

Writing return Statements 

If you want a method to return information (in other words, its return type is not void), 
you must write a return statement inside the method. You do this using the keyword 

return followed by an expression that calculates the returned value and a semicolon. The 
type of expression must be the same as the type specified by the function. In other 

words, if a function returns an int, the return statement must return an int; otherwise 

your program will not compile. Here is an example: 

int addValues(int leftHandSide, int rightHandSide)   
{   
    // ...   

    return leftHandSide + rightHandSide;  
} 

The return statement should be at the end of your method because it causes the method 
to finish. Any statements after the return statement are not executed (though the 

compiler warns you about this problem if you put statements after the return 
statement). 

If you don't want your method to return information (in other words, its return type is 
void), you can use a variation of the return statement to cause an immediate exit from 

the method. You write the keyword return, immediately followed by a semicolon. For 
example: 

void showResult(int answer)   

{   
    // display the answer  
    ...  
    return;  

} 

If your method does not return anything, you can also omit the return statement, 
because the method finishes automatically when execution arrives at the closing curly 

brace at the end of the method. Although this practice is common, it is not always 
considered good style. 

In the following exercise, you will examine another version of the MathsOperators 

application from Chapter 2. This version has been improved by the careful use of some 

small methods. 
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TIP 

There is no minimum size for a method. If a method helps to avoid repetition and makes 
your program easier to understand, the method is useful regardless of how small it is. 

 
There is also no maximum line length for a method, but usually you want to keep your 

method code small enough to get the job done. If your method is more than one screen 
in length, consider breaking it into smaller methods for readability. 

Examine method definitions 

1. Start Visual Studio 2005. 
2. Open the Methods project in the \Microsoft Press\Visual CSharp Step by 

Step\Chapter 3\Methods folder in your My Documents folder. 

3. On the Debug menu, click Start Without Debugging. 

Visual Studio 2005 builds and runs the application. 

4. Re-familiarize yourself with the application and how it works, and then click Quit. 
5. Display the code for Form1.cs in the Code and Text Editor window (right-click 

Form1.cs in the Solution Explorer and click View Code). 

6. In the Code and Text Editor window, locate the addValues method. 

The method looks like this: 

private int addValues(int leftHandSide, int rightHandSide) 
{ 
    expression.Text = leftHandSide.ToString() + " + " + rightHandSide.ToString(); 

    return leftHandSide + rightHandSide;  
} 

The addValues method contains two statements. The first statement displays the 

calculation being performed in the expression TextBox on the form. The values of 
the parameters leftHandSide and rightHandSide are converted into strings (using 

the ToString method you met in Chapter 2), and concatenated together with a “+” 
sign in the middle. 

The second statement uses the + operator to add the values of the leftHandSide 

and rightHandSide int variables together and returns the result of this addition. 
Remember that adding two int values together creates another int value, so the 

return type of addValues is int. 

7. In the Code and Text Editor window, locate the showResult method. 

The showResult method looks like this: 

private void showResult(int answer) 
{ 
    result.Text = answer.ToString(); 
} 

This method contains one statement that displays a string representation of the 
answer parameter in the result TextBox. 
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Calling Methods 

Methods exist to be called! You call a method by name to ask it to perform its task. If 

the method requires information (as specified by its parameters), you must supply the 
information requested. If the method returns information (as specified by its return 

type), you should arrange to capture this information somehow. 

Specifying the Method Call Syntax 

The syntax of a C# method call is as follows: 

methodName ( argumentList ) 

• The methodName must exactly match the name of the method you're calling. 
Remember, C# is a case-sensitive language. 

• The argumentList supplies the optional information that the method accepts. You 

must supply an argument for each parameter, and the value of each argument 
must be compatible with the type of its corresponding parameter. If the method 

you're calling has two or more parameters, you must separate the arguments with 
commas. 

IMPORTANT 
You must include the parentheses in every method call, even when calling a 

method that has no arguments. 

Here is the addValues method again: 

int addValues(int leftHandSide, int rightHandSide)   
{   

    // ...   
} 

The addValues method has two int parameters, so you must call it with two comma-
separated int arguments: 

addValues(39, 3);     // okay 

You can also replace the literal values 39 and 3 with the names of int variables. The 
values in those variables are then passed to the method as its arguments, like this: 

int arg1 = 99; 

int arg2 = 1; 
addValues(arg1, arg2); 

If you try to call addValues in some other way, you will probably not succeed, for the 
reasons described in the following examples: 
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addValues;            // compile time error, no parentheses  
addValues();          // compile time error, not enough arguments  

addValues(39);        // compile time error, not enough arguments  
addValues("39", "3"); // compile time error, wrong types 

The addValues method returns an int value. This int value can be used wherever an int 
value can be used. Consider these examples: 

result = addValues(39, 3);    // on right hand side of an assignment  
showResult(addValues(39, 3)); // as argument to another method call 

The following exercise continues using the MathsOperators application. This time you will 
examine some method calls. 

Examine method calls 

1. Return to the Methods project. (This project is already open in Visual Studio 2005 
if you're continuing from the previous exercise. If you are not, open it from the 

\Microsoft Press\Visual CSharp Step by Step\Chapter 3\Methods folder in your My 
Documents folder. 

2. Display the code for Form1.cs in the Code and Text Editor window. 
3. Locate the calculate_Click method, and look at the first two statements of this 

method after the try statement and opening curly brace. (We will cover the 
purpose of try statements in Chapter 6, “Managing Errors and Exceptions.”) 

The statements are as follows: 

int leftHandSide = System.Int32.Parse(leftHandSideOperand.Text);  
int rightHandSide = System.Int32.Parse(rightHandSideOperand.Text); 

These two statements declare two int variables called leftHandSide and 

rightHandSide. However, the interesting parts are the way in which the variables 
are initialized. In both cases, the Parse method of the System.Int32 class is called 

(System is a namespace, Int32 is the name of the class in this namespace). This 
method takes a single string parameter and converts it to an int value. These two 

lines of code take whatever the user has typed into the leftHandSideOperand and 
rightHandSideOperand TextBox controls on the form and converts them into int 

values. 

4. Look at the fourth statement in the calculate_Click method (after the if statement 
and another opening curly brace): 

calculatedValue = addValues(leftHandSide, rightHandSide)); 

This statement calls the addValues method, passing the values of the leftHandSide 
and rightHandSide variables as its arguments. The value returned by the 

addValues method is stored in the calculatedValue variable. 

5. Look at the next statement: 

showResult(calculatedValue); 
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This statement calls the showResult method, passing the value in the 

calculatedValue variable as its argument. The showResult method does not return 
a value. 

6. In the Code and Text Editor window, find the showResult method you looked at 

earlier. 

The only statement of this method is this: 

result.Text = answer.ToString(); 

Notice that the ToString method call uses parentheses even though there are no 

arguments. 

TIP 
You can call methods belonging to other objects by prefixing the method with the 

name of the object. In the previous example, the expression answer.ToString() 
calls the method named ToString belonging to the object called answer. 

Applying Scope 

You have seen in some of the examples that you can create a variable inside a method. 

The variable comes into existence at the point where a statement defines it, and 
subsequent statements in the same method can then use the variable. In other words, a 

variable can be used only after it has been created. After the method has finished, the 
variable disappears completely. 

If a variable can be used at a particular location in a program, the variable is said to be 

in scope at that location. To put it another way, the scope of a variable is simply the 

region of the program in which that variable is usable. Scope applies to methods as well 
as variables. The scope of an identifier (of a variable or method) is linked to the location 

of the declaration that introduces the identifier into the program, as you'll now learn. 

Defining Local Scope 

The opening and closing curly braces that form the body of a method define a scope. 
Any variables you declare inside the body of a method are scoped to that method; they 
disappear when the method ends and can be accessed only by code running within that 

method. These variables are called local variables because they are local to the method 
in which they are declared; they are not in scope in any other method. This arrangement 

means that you cannot use local variables to share information between methods. 
Consider this example: 

class Example  
{  
    void firstMethod()  
    {  

        int myVar;  
        ...  
    }  
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    void anotherMethod()  
    {  

        myVar = 42; // error – variable not in scope  
        ...  
    }  
} 

This code would fail to compile because anotherMethod is trying to use the variable 
myVar which is not in scope. The variable myVar is available only to statements in 
firstMethod. 

Defining Class Scope 

The opening and closing curly braces that form the body of a class also create a scope. 
Any variables you declare inside the body of a class (but not inside a method) are 

scoped to that class. The proper C# name for the variables defined by a class is fields. 
Unlike local variables, you can use fields to share information between methods. Here is 

an example: 

class Example  
{  

    void firstMethod()  
    {  
        myField = 42; // ok  

        ...  
    }  
  
    void anotherMethod()  

    {  
        myField = 42; // ok  
        ...  
    }  

  
    int myField = 0;  
} 

The variable myField is defined within the class, but outside of the methods firstMethod 
and anotherMethod. Therefore, myField has class scope and is available for use by all 
methods in the class. 

There is one other point to notice about this example. In a method, you must declare a 
variable before you can use it. Fields are a little different. A method can use a field 

before the statement that defines the field—the compiler sorts out the details for you! 

Overloading Methods 

If two identifiers have the same name and are declared in the same scope, they are said 
to be overloaded. Often an overloaded identifier is a bug that gets trapped as a compile-
time error. For example, if you declare two local variables with the same name in the 

same method, you get a compile-time error. Similarly, if you declare two fields with the 
same name in the same class or two identical methods in the same class, you also get a 

compile-time error. This fact might seem hardly worth mentioning, given that everything 
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so far has turned out to be a compile-time error. However, there is a way that you can 

overload an identifier, and that way is both useful and important. 

Consider the WriteLine method of the Console class. You have already used this method 
for outputting a string to the screen. However, when you type WriteLine in the Code and 

Text Editor window when writing C# code, you will notice that IntelliSense gives you 19 
different options! Each version of the WriteLine method takes a different set of 

parameters; one implementation takes no parameters and simply outputs a blank line, 
another implementation takes a bool parameter and outputs a string representation of 

its value (true or false), yet another implementation takes a decimal parameter and 
outputs it as a string, and so on. At compile time, the compiler looks at the types of the 

arguments you are passing in and then calls the version of the method that has a 

matching set of parameters. Here is an example: 

static void Main()  
{  
    Console.WriteLine("The answer is ");  

    Console.WriteLine(42);  
} 

Overloading is primarily useful when you need to perform the same operation on 
different data types. You can overload a method when the different implementations 

have different sets of parameters; that is, when they have the same name but a 
different number of parameters, or when the types of the parameters differ. This 

capability is allowed so that, when you call a method, you can supply a comma-
separated list of arguments, and the number and type of the arguments is used by the 

compiler to select one of the overloaded methods. However, note that although you can 

overload the parameters of a method, you can't overload the return type of a method. 
In other words, you can't declare two methods with the same name that differ only in 

their return type. (The compiler is clever, but not that clever.) 

Writing Methods 

In the following exercises, you'll create an application method that calculates how much 
a consultant would charge for a given number of consultancy days at a fixed daily rate. 
You will start by developing the logic for  

 

the application and then use the Generate Method Stub Wizard to help you write the 
methods that are used by this logic. Next, you'll run these methods in a console 

application to get a feel for the program. Finally, you'll use the Visual Studio 2005 
debugger to step in and out of the method calls as they run. 

 
Develop the logic for the application 

1. Using Visual Studio 2005, open the DailyRate project in the \Microsoft Press\Visual 
CSharp Step by Step\Chapter 3\DailyRate folder in your My Documents folder. 
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2. In the Solution Explorer, double-click the file Program.cs to display the program in 

the Code and Text Editor window. 
3. Add the following statements to the body of the run method: 
4. double dailyRate = readDouble("Enter your daily rate: ");  
5. int noOfDays = readInt("Enter the number of days: ");  

writeFee(calculateFee(dailyRate, noOfDays)); 

The run method is called by the Main method when the application starts (the way 

in which it is called requires an understanding of classes, which we will look at in 
Chapter 7, “Creating and Managing Classes and Objects”) . 

The block of code you have just added to the run method calls the readDouble 

method (which you will write shortly) to ask the user for the daily rate for the 
consultant. The next statement calls the readInt method (which you will also 

write) to obtain the number of days. Finally, the writeFee method (to be written) is 
called to display the results on the screen. Notice that the value passed to 

writeFee is the value returned by the calculateFee method (the last one you will 

need to write), which takes the daily rate and the number of days and calculates 
the total fee payable. 

 

NOTE 
Because you have not yet written the readDouble, readInt, writeFee, or calculateFee 

methods, IntelliSense does not display them when you type this code. Also, do not try to 
build the application yet, because it will fail. 

Write the methods using the Generate Method Stub Wizard 

1. In the Code and Text Editor window, click the readDouble method call in the run 

method. 

A small underscore character appears underneath the first letter ("r") of 
readDouble. If you move the cursor over the letter "r", an icon appears. If you 

hover the mouse over this icon,the tooltip "Options to generate a method stub 
(Shift + Alt + F10)" appears, with a drop-down menu. Click the drop-down menu, 

and the option “Generate method stub for 'readDouble' in 'DailyRate.Program'” 

apppears, as shown here: 
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1. Click Generate method stub for 'readDouble' in 'DailyRate.Program'. 

The Generate Method Stub Wizard examines the call to the readDouble method, 

ascertains the type of its parameters and return value, and generates a method 
with a default implementation, like this: 

private double readDouble(string p) 
{ 
    throw new Exception("The method or operation is not implemented."); 
} 

The new method is created with the private qualifier, which will be described in 
Chapter 7. The body of the method currently just throws an Exception. (Exceptions 
will be described in Chapter 6.) You will replace the body with your own code in 

the next step. 

2. Delete the throw new Exception(…); statement from the readDouble method, and 

replace it with the following lines of code: 
3. Console.Write(p);  
4. string line = Console.ReadLine();  

return double.Parse(line); 

This block of code outputs the string in variable p to the screen. This variable is 
the string parameter passed in when the method is called, and contains a message 

prompting the user to type in their daily rate. The user types in a value, which is 
read into a string by using the ReadLine method and converted into a double by 

using the double.Parse method. The result is passed back as the return value of 
the method call. 

NOTE 
The ReadLine method is the companion method to WriteLine; it reads user input 
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from the keyboard, finishing when the user presses the Enter key. The text typed 

by the user is passed back as the return value. 

5. Click the call to the readInt method in the run method, and use the same process 
as before to generate a method stub for the readInt method. 

The readInt method is generated with a default implementation. 

TIP 
You can also generate a method stub by right-clicking a method call and selecting 

Generate Method Stub from the context menu. 

6. Replace the body of the readInt method with the following statements: 
7. Console.Write(p);  

8. string line = Console.ReadLine();  
return int.Parse(line); 

This block of code is very similar to the readDouble method. The only difference is 
that the method returns an int value, so the string is converted into a number by 

using the int.Parse method. 

9. Right-click the call to the calculateFee method in the run method, and then click 

Generate Method Stub. 

The calculateFee method is generated: 

private object calculateFee(double dailyRate, int noOfDays)  
{  

    throw new Exception("The method or operation is not implemented");  
} 

Notice that the Generate Method Stub Wizard uses the name of the arguments 
passed in to generate names for the parameters. (You can of course change the 

parameter names if they are not suitable.) What is more intriguing is the type 

returned by the method, which is object. The Generate Method Stub Wizard is 
unable to determine exactly what type of value should be returned by the method 

from the context in which it is called. The object type just means a “thing,” and 
you should change it to the type you require when you add the code to the 

method. The object type will be described in more detail in Chapter 7. 

10. Change the definition of the calculateFee method so that it returns a double: 
11. private double calculateFee double dailyRate, int noOfDays)  

12. {  
13.     throw new Exception("The method or operation is not implemented");  

} 

14. Replace the body of the calculateFee method with the following statement, 
which calulates the fee payable by multiplying the two parameters together and 
then returns it: 

return dailyRate * noOfDays; 
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15. Right-click the call to the writeFee method in the run method, then click 

Generate Method Stub. 

The writeFee method is generated. Note that the Generate Method Stub Wizard 
uses the definition of the calculateFee method to work out that its parameter 

should be a double. Also, the method call does not use a return value, so the type 
of the method is void: 

private void writeFee(double p)  
{  
    ...  
} 

16. Type the following statements inside the writeFee method: 

Console.WriteLine("The consultant's fee is: {0}", p * 1.1); 

NOTE 
This version of the WriteLine method demonstrates the use of a simple format 

string. The text {0} is a placeholder that is replaced with the value of the 
expression following the string (p * 1.1) when it is evaluated at runtime. 

17. On the Build menu, click Build Solution. 

TIP 

If you feel sufficiently comfortable with the syntax, you can also write methods by typing 

them directly in the Code and Text Editor window. You do not always have to use the 
Generate Method Stub menu option. 

 
 

 

 
Test the program 

1. On the Debug menu, click Start Without Debugging. 

Visual Studio 2005 builds the program and then runs it. A console window 
appears. 

Refactoring Code 

A very useful feature of Visual Studio 2005 is the ability to refactor code. 

Occasionally you will find yourself writing the same (or very similar) code in more than one place in an 

application. When this occurs, highlight the block of code you have just typed, and click Extract Method on 

the Refactor menu. The Extract Method dialog box appears, prompting you for the name of a new method to 

create containing this code. Type a name and click OK. The new method is created containing your code, 

and the code you typed is replaced with a call to this method. The Extract Method is also intelligent enough 

to work out whether the method should take any parameters and return a value. 
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2. At the Enter Your Daily Rate prompt, type 525, and then press Enter. 

3. At the Enter The Number Of Days prompt, type 17, and then press Enter. 

The program writes the following message to the console window: 

The consultant's fee is: 9817.5 

4. Press the Enter key to return control to the Visual Studio 2005 programming 
environment. 

In the final exercise, you'll use the Visual Studio 2005 debugger to run your program in 
slow motion. You'll see when each method is called (this action is referred to as stepping 

into the method) and then see how each return statement transfers control back to the 
caller (also known as stepping out of the method). While you are stepping in and out of 

methods, you'll use the tools on the Debug toolbar. However, the same commands are 
also available on the Debug menu when an application is running in Debug mode. 

Step through the methods using the Visual Studio 2005 debugger 

1. In the Code and Text Editor window, find the run method. 
2. Move the mouse pointer to the first statement in the run method. 

The first statement in the run method is as follows: 

double dailyRate = readDouble("Enter your daily rate: "); 

3. Right-click anywhere on this line, and on the context menu, click Run To Cursor. 

The program runs until it reaches the first statement in the run method, and then 
it pauses. A yellow arrow in the left margin of the Code and Text Editor window 

indicates the current statement, which is also highlighted with a yellow 
background. 

4. On the View menu, point to Toolbars, and then make sure the Debug toolbar is 
checked. 

If it was not already visible, the Debug toolbar opens. It might appear docked with 

the other toolbars. If you cannot see the toolbar, try using the Toolbars command 
on the View menu to hide it, and notice which buttons disappear. Then display the 

toolbar again. The Debug toolbar looks like this: 

           

TIP 
To make the Debug toolbar appear in its own window, use the handle at the left 

end of the toolbar to drag it over the Code and Text Editor window. 

5. On the Debug toolbar, click Step Into. 
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This action causes the debugger to step into the method being called. The yellow 

cursor jumps to the opening curly brace at the start of the readDouble method. 
Click Step Into again. The cursor advances to the first statement: 

Console.Write(p); 

TIP 
You can also press F11 rather than clicking Step Into on the Debug toolbar. 

6. On the Debug toolbar, click Step Over. 

This action causes the method to execute the next statement without debugging it 

(stepping into it). The yellow cursor moves to the second statement of the 
method, and the program displays the Enter Your Daily Rate prompt in a Console 

window before returning to Visual Studio 2005 (the Console window may be 
hidden behind Visual Studio). 

TIP 

You can also press F10 rather than clicking Step Over. 

7. On the Debug toolbar, click Step Over. 

This time the yellow cursor disappears and the Console window gets the focus 

because the program is executing the Console.ReadLine method and is waiting for 
you to type something in. 

8. Type 525 in the Console window, and then press Enter. 

Control returns to Visual Studio 2005. The yellow cursor appears on the third line 
of the method. 

9. Without clicking, move the mouse over the reference to the line variable on either 
the second or the third line of the method (it doesn't matter which). 

A ScreenTip appears, displaying the current value of the line variable (“525”). You 

can use this feature to make sure that a variable has been set to an expected 
value while stepping through methods. 

10. On the Debug toolbar, click Step Out. 

This action causes the current method to continue running uninterrupted to its 
end. The readDouble method finishes, and the yellow cursor is placed back at the 

first statement of the run method. 

TIP 

You can also press Shift+F11 rather than clicking Step Out. 

11. On the Debug toolbar, click Step Into. 

The yellow cursor moves to the second statement in the run method: 
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int noOfDays = readInt("Enter the number of days: "); 

12. On the Debug toolbar, click Step Over. 

This time you have chosen to run the method without stepping through it. The 

Console window appears again prompting you for the number of days. 

13. In the Console window, type 17, and then press Enter. 

Control returns to Visual Studio 2005. The yellow cursor moves to the third 

statement of the run method: 

writeFee(calculateFee(dailyRate, noOfDays)); 

14. On the Debug toolbar, click Step Into. 

The yellow cursor jumps to the opening curly brace at the start of the calculateFee 
method. This method is called first, before writeFee. 

15. On the Debug toolbar, click Step Out. 

The yellow cursor jumps back to the third statement of the run method. 

16. On the Debug toolbar, click Step Into. 

This time, the yellow cursor jumps to the opening curly brace at the start of the 

writeFee method. 

17. Place the mouse over the p variable in the method definition. 

The value of p, 8925.0, is displayed. 

18. On the Debug toolbar, click Step Out. 

The message The consultant's fee is: 9817.5 is displayed in the Console window. 
(You might need to bring the Console window to the foreground to display it if it is 

hidden behind Visual Studio 2005). The yellow cursor returns to the third 
statement in the run method. 

19. On the Debug toolbar, click Continue to cause the program to continue 

running without stopping at each statement. 

TIP 

You can also press F5 to continue execution in the Debugger. 

The application finishes running. 

Congratulations! You've successfully written and called methods and used the Visual 

Studio 2005 debugger to step in and out of methods as they run. 
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• If you want to continue to the next chapter 

Keep Visual Studio 2005 running, and turn to Chapter 4. 

• If you want to exit Visual Studio 2005 now 

On the File menu, click Exit. If you see a Save dialog box, click Yes to save your 
work. 

Chapter 3 Quick Reference 

 
To Do this 

Declare a method Write the method inside a class. For example: 

int addValues(int leftHandSide, int rightHandSide) 

{ 
  ... 
} 

Return a value from inside a 
method 

Write a return statement inside the method. For 
example: 

return leftHandSide + rightHandSide; 

Return from a method before 
the end of the method 

Write a return statement inside the method. For 
example: 

return; 

Call a method Write the name of the method, together with any 

arguments between parentheses. For example: 

addValues(39, 3); 

Use the Generate Method Stub 

Wizard 

Highlight a call to the method, and then click Generate 

Method Stub on the IntelliSense menu. 

Display the Debug toolbar On the View menu, point to Toolbars, and then click 
Debug. 

Step into a method On the Debug toolbar, click Step Into. 

or 

On the Debug menu, click Step Into. 

Step out of a method On the Debug toolbar, click Step Out. 

or 

On the Debug menu, click Step Out. 

 

Chapter 4 

Using Decision Statements 
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After completing this chapter, you will be able to: 

• Declare bool variables. 
• Use Boolean operators to create expressions whose outcome is either true or false. 
• Write if statements to make decisions based on the result of a Boolean expression. 

• Write switch statements to make more complex decisions. 

In Chapter 3, “Writing Methods and Applying Scope,” you learned how to group related 

statements into methods. You also learned how to use arguments and parameters to 
pass information to a method and how to use return statements to pass information out 

of a method. Dividing a program up into a set of discrete methods, each designed to 
perform a specific task or calculation, is a recommended design strategy. Many 

programs need to solve large and complex problems. Breaking up a program into 
methods helps you understand these problems and focus on how to solve them one 

piece at a time. You also need to be able to write methods that selectively perform 
different actions depending on the circumstances. In this chapter, you'll see how to 

accomplish these tasks. 

Declaring bool Variables 

In the world of programming (unlike in the real world), everything is black or white, 
right or wrong, true or false. For example, if you create an integer variable called x, 

assign the value 99 to x, and then ask, “Does x contain the value 99?”, the answer is 
definitely true. If you ask, “Is x less than 10?”, the answer is definitely false. These are 

examples of Boolean expressions. A Boolean expression always evaluates to true or 
false. 

NOTE 

The answers to these questions are not definitive for all programming languages. An 
unassigned variable has an undefined value, and you cannot, for example, say that it is 

definitely less than 10. Issues such as this one are a common source of errors in C and 
C++ programs. The Microsoft Visual C# compiler solves this problem by ensuring that 

you always assign a value to a variable before examining it. If you try to examine the 

contents of an unassigned variable, your program will not compile. 

Microsoft Visual C# provides a data type called bool. A bool variable can hold one of two 
values: true or false. For example, the following three statements declare a bool variable 

called areYouReady, assign true to the variable, and then write its value to the console: 

bool areYouReady;  
areYouReady = true;  

Console.WriteLine(areYouReady); // writes True 

 
Using Boolean Operators 

A Boolean operator is an operator whose result is either true or false. C# has several 

very useful Boolean operators, the simplest of which is the NOT operator, which is 
represented by the exclamation point symbol (!). The ! operator negates a Boolean 
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value, yielding the opposite of that value. In the previous example, if the value of the 

variable areYouReady is true, the value of the expression !areYouReady is false. 

Understanding Equality and Relational Operators 

Two much more commonly used Boolean operators are the equality (==) and inequality 
(!=) operators. You use these binary operators to find out whether a value is the same 

as another value of the same type. The following table summarizes how these operators 

work, using an int variable called age as an example. 

Operator Meaning Example Outcome if age is 42 
-- Equal to age -- 100 false 
!= Not equal to age != 0 true 

Closely related to these two operators are the relational operators. You use these 
operators to find out whether a value is less than or greater than another value of the 

same type. The following table shows how to use these operators. 

Operator Meaning Example Outcome if age is 42 

< Less than age < 21 false 

<= Less than or equal to age <= 18 false 

> Greater than age > 16 true 

>= Greater than or equal to age >= 30 true 

 
NOTE 

Don't confuse the equality operator == with the assignment operator =. Code such as 
x==y compares x to y and has the value true if the values are the same. Code such as 

x=y assigns the value of y to x. 
Understanding Conditional Logical Operators 

C# also provides two other Boolean operators: the logical AND operator, which is 
represented by the && symbol, and the logical OR operator, which is represented by the 

|| symbol. Collectively, these are known as the conditional logical operators. Their 
purpose is to combine Boolean expressions together into bigger expressions. These 

binary operators are similar to the equality and relational operators in that their 
outcome is either true or false, but they differ in that the values they operate on must 

themselves be either true or false. 

The outcome of the && operator is true if and only if both of the Boolean expressions it 
operates on are true. For example, the following statement assigns the value true to 

validPercentage if and only if the value of percent is greater than or equal to zero and 
the value of percent is less than or equal to 100: 

bool validPercentage;  
validPercentage = (percent >= 0) && (percent <= 100); 

TIP 

A common beginner's error is to try to combine the two tests by naming the percent 
variable only once, like this:  
percent >= 0 && <= 100 // this statement will not compile. 
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Using parentheses helps avoid this type of mistake and also clarifies the purpose of the 

expression. For example, compare these two expressions:  
validPercentage = percent >= 0 && percent <= 100  validPercentage = (percent >= 0) && 
(percent <= 100) 

Both expressions return the same value, because the precedence of the && operator is 
less than that of >= and <=. However, the second expression conveys its purpose in a 

more readable manner. 

The outcome of the || operator is true if either of the Boolean expressions it operates on 
is true. You use the || operator to determine whether any one of a combination of 

Boolean expressions is true. For example, the following statement assigns the value true 
to invalidPercentage if the value of percent is less than zero, or the value of percent is 

greater than 100: 

bool invalidPercentage;  
invalidPercentage = (percent < 0) || (percent > 100); 

 

 

 
Summarizing Operator Precedence and Associativity 

The following table summarizes the precedence and associativity of all the operators you 
have learned about so far. Operators in the same category have the same precedence. 

Operators in a higher category take precedence over operators in a lower category. 

Short Circuiting 

The && and || operators both exhibit a feature called short circuiting. Sometimes it is 

not necessary to evaluate both operands. For example, if the left operand of the && 
operator evaluates to false, then the result of the entire expression is false regardless of 

the value of the right operand. Similarly, if the value of the left operand of the || 
operator evaluates to true, the result of the entire expression is true. In these cases, the 

&& and || operators bypass the evaluation of the right Boolean expressions. Here are 
some examples: 

(percent >= 0) && (percent <= 100) 

In this expression, if the value of percent is less than zero, the Boolean expression on 
the left side of && evaluates to false. This value means that the result of the entire 

expression must be false, regardless of the remaining expression; therefore, the Boolean 
expression on the right side of && is not evaluated. 

(percent < 0) || (percent > 100) 

In this expression, if the value of percent is less than zero, the Boolean expression on 
the left side of || evaluates to true. This value means that the result of the entire 
expression must be true; therefore, the Boolean expression on the right side of || is not 

evaluated. 
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Category Operators Description Associativity 

Primary ( ) 

++ 

-- 

Precedence override 

Post-increment 

Post-decrement 

Left 

Unary ! 

+ 
- 

++ 
-- 

Logical NOT 

Addition 
Subtraction 

Pre-increment 
Pre-decrement 

Left 

Multiplicative * 

/  
% 

Multiply 

Divide 
Division remainder 

Left 

Additive + 
- 

Addition 
Subtraction 

Left 

Relational < 

<= 
> 

>= 

Less than 

Less than or equal 
Greater than  

Greater than or equal 

Left 

Equality == 

!= 

Equal to 

Not equal to 

Left 

Conditional AND && Logical AND Left 

Conditional OR || Logical OR Left 

Assignment =  Right 

 

Using if Statements to Make Decisions 

You use an if statement when you want to choose between executing two different 
blocks of code depending on the result of a Boolean expression. 

Understanding if Statement Syntax 

The syntax of an if statement is as follows (if and else are keywords): 

if ( booleanExpression )  
    statement-1;  

else  
    statement-2; 

If booleanExpression evaluates to true, then statement-1 runs; otherwise 
booleanExpression is false, and statement-2 runs. The else keyword and the following 

statement-2 are optional. If there is no else clause, nothing happens when the 
booleanExpression is false. 
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For example, here's an if statement that increments the seconds hand of a stopwatch 

(minutes are ignored for now). If the value of the seconds variable is 59, it is reset to 0, 
otherwise it is incremented using the ++ operator: 

int seconds;  

...  
if (seconds == 59)  
    seconds = 0;  
else  

    seconds++; 

 

 

Using Blocks to Group Statements 

Sometimes you'll want to run two or more statements when a Boolean expression is 
true. You could group the statements inside a new method and then call the new 

method, but a simpler solution is to group the statements inside a block. A block is 
simply a sequence of statements grouped between an opening and a closing curly brace. 

In the following example, two statements that reset the seconds variable to zero and 

increment the minutes variable are grouped inside a block, and the whole block executes 
if the value of seconds is equal to 59: 

 Boolean Expressions Only Please! 

The expression in an if statement must be enclosed in parentheses. Additionally, the expression must be a 

Boolean expression. In some other languages (notably C and C++), you can write an integer expression, and 

the compiler will silently convert the integer value to true (nonzero) or false (zero). C# does not support this 

behavior, and the compiler reports an error if you write such an expression. 

If you accidentally write an assignment instead of an equality test in an if statement, the C# compiler 

recognizes your mistake. For example: 

int seconds;  

...  

if (seconds = 59)  // compile-time error  

...  

if (seconds == 59) // ok 

Accidental assignments were another common source of bugs in C and C++ programs, which would silently 

convert the value assigned (59) into a Boolean expression (anything non-zero was considered to be true), 

with the result that the code following the if statement would be performed every time. 

Finally, you can use a Boolean variable as the expression, as in this example: 

bool inWord;  

...  

if (inWord == true) // ok, but not commonly used  

...  
if (inWord)         // better 
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int seconds = 0;  
int minutes = 0;  

...  
if (seconds == 59)  
{  
    seconds = 0;  

    minutes++;  
}  
else  
    seconds++; 

IMPORTANT 
If you omit the curly braces, the C# compiler associates only the first statement 

(seconds = 0) with the if statement. The subsequent statement (minutes++) will not be 
recognized by the compiler as part of the if statement when the program is compiled. 

Furthermore, when the compiler reaches the else keyword, it will not associate it with 
the previous if statement, so it reports a syntax error instead. 

Cascading if Statements 

You can nest if statements inside other if statements. In this way, you can chain 
together a sequence of Boolean expressions, which are tested one after the other until 
one of them evaluates to true. In the following example, if the value of day is 0, the first 

test evaluates to true and dayName is assigned Sunday. If the value of day is not 0, the 
first test fails and control passes to the else clause, which runs the second if statement 

and compares the value of day with 1. The second if statement is reached only if the 
first test is false. Similarly, the third if statement is reached only if the first and second 

tests are false. 

if (day == 0)  
    dayName = "Sunday";  

else if (day == 1)  
    dayName = "Monday";  
else if (day == 2)  
    dayName = "Tuesday";  

else if (day == 3)  
    dayName = "Wednesday";  
else if (day == 4)  

    dayName = "Thursday";  
else if (day == 5)  
    dayName = "Friday";  
else if (day == 6)  

    dayName = "Saturday";  
else  
    dayName = "unknown"; 

In the following exercise, you'll write a method that uses a cascading if statement to 
compare two dates. 

Write if statements 

1. Start Microsoft Visual Studio 2005. 

2. Open the Selection project, located in the \Microsoft Press\Visual CSharp Step by 
Step\Chapter 4\Selection folder in your My Documents folder. 

3. On the Debug menu, click Start Without Debugging. 
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Visual Studio 2005 builds and runs the application. There are two DateTimePicker 

controls on the form called first and second. (These controls display a calendar 
allowing you to select a date when you click the drop-down arrow.) Both controls 

are currently set to today's date. 

4. Click Compare. 

The following text appears in the text box: 

first == second : False  
first != second : True  

first <  second : False  
first <= second : False  
first >  second : True  

first >= second : True 

The Boolean expression first == second should be true because both first and 
second are set to today's date. In fact, only the less than operator and the greater 

than or equal to operator seem to be correct! 

 

 

             

5. Click Quit. 

You return to the Visual Studio 2005 programming environment. 

6. Display the code for Form1.cs in the Code and Text Editor window. Locate the 
compare_Click method, which looks like this: 

private int compare_Click(object sender, System.EventArgs e)  

{  
    int diff = dateCompare(first.Value, second.Value); 
    info.Text = ""; 

    show("first == second", diff == 0); 
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    show("first != second", diff != 0); 
    show("first < second", diff < 0); 

    show("first <= second", diff <= 0); 
    show("first > second", diff > 0); 
    show("first >= second", diff >= 0);  
} 

This method runs whenever the user clicks the Compare button on the form. It 
retrieves the values of the dates displayed in the first and second DateTimePicker 
controls on the form and calls another method called dateCompare to compare 

them. You will examine the dateCompare method in the next step, but its purpose 
is to examine its arguments and return an integer value based on their relative 

values; it returns zero if they have the same value, -1 if the value of first is less 

than the value of second, and +1 if the value if first is greater than the value of 
second. (A date is considered greater than another date if it comes after it 

chronologically.) 

The show method summarizes the results of the comparison in the info TextBox 
control on the form. 

7. Locate the dateCompare method, which looks like this: 

   private int dateCompare(DateTime leftHandSide, DateTime rightHandSide)  
   {  
    // TO DO  

    return 42;  
} 
 
This method currently returns the same value whenever it is called, rather than 0, -1, or +1 

depending on the values of its parameters. This explains why the application is not working as 
expected! You need to implement this method to correctly compare two dates. 

8. Remove the // TO DO comment and the return statement from the dateCompare 
method. 

9. Type the following statements in the body of the dateCompare method: 

int result;  
if (leftHandSide.Year < rightHandSide.Year)  

    result = -1;  
else if (leftHandSide.Year > rightHandSide.Year)  
    result = +1;  

else if (leftHandSide.Month < rightHandSide.Month)  
    result = -1;  
else if (leftHandSide.Month > rightHandSide.Month)  
    result = +1;  

else if (leftHandSide.Day < rightHandSide.Day)  
    result = -1;  
else if (leftHandSide.Day > rightHandSide.Day)  
    result = +1;  

else  
    result = 0;  

return result; 
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If the expressions leftHandSide.Year < rightHandSide.Year and 

leftHandSide.Year > rightHandSide.Year are false, then leftHandSide.Year == 
rightHandSide.Year must be true, and the program flow correctly moves on to 

compare the Month property of lhs and rhs. Similarly, if leftHandSide.Month < 
rightHandSide.Month and leftHandSide.Month > rightHandSide.Month are false, 

then leftHandSide.Month == rightHandSide.Month must be true, and the program 
flow again correctly moves on to compare the Day property of lhs and rhs. Lastly, 

if leftHandSide.Day < rightHandSide.Day and leftHandSide.Day > 
rightHandSide.Day are false, then leftHandSide.Day == rightHandSide.Day must 

be true, and, because the Month and Year properties must also be true, the two 
dates must be the same. 

10. On the Debug menu, click Start Without Debugging. 

The application is rebuilt and restarted. Once again, the two DateTimePicker 
controls, first and second, are set to today's date. 

11. Click Compare. 

The following text appears in the text box: 

first == second : True  
first != second : False  
first <  second : False  

first <= second : True  
first >  second : False  
first >= second : True 

These are the correct results. 

12. Move the second DateTimePicker control onto tomorrow's date. 

13. Click Compare. 

The following text appears in the text box: 

first == second : False  

first != second : True  
first <  second : True  
first <= second : True  
first >  second : False  

first >= second : False 

Again, these are the correct results. 

14. Click Quit. 

Using switch Statements 

Sometimes when you write a cascading if statement, all the if statements look very 
similar, because they all evaluate an identical expression. The only difference is that 

each if compares the result of the expression with a different value. For example: 
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if (day == 0)  
    dayName = "Sunday";  

else if (day == 1)  
    dayName = "Monday";  
else if (day == 2)  
    dayName = "Tuesday";  

else if (day == 3)  
    ...  
else  
    dayName = "Unknown"; 

In these situations, you can often rewrite the cascading if statement as a switch 
statement to make your program more efficient and more readable. 

Understanding switch Statement Syntax 

The syntax of a switch statement is as follows (switch, case, and default are keywords): 

switch ( controllingExpression )  
{  
case constantExpression :  
    statements  

    break;  
case constantExpression :  
    statements  

    break;  
...  
default :  
    statements  

    break;  
} 

The controllingExpression is evaluated once, and the statements below the case whose 
constantExpression value is equal to the result of the controllingExpression run as far as 

the break statement. The switch statement then finishes, and the program continues at 
the first statement after the closing brace of the switch statement. 

If none of the constantExpression values are equal to the value of the 
controllingExpression, the statements below the optional default label run. 

NOTE 

If the value of the controllingExpression does not match any of the case labels and 
there's no default label, program execution continues with the first statement after the 

closing brace of the switch statement. 

For example, you can rewrite the previous cascading if statement as the following switch 
statement: 

switch (day)  
{  
case 0 :  

    dayName = "Sunday";  
    break;  
case 1 :  
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    dayName = "Monday";  
    break;  

case 2 :  
    dayName = "Tuesday";  
    break;  
...  

default :  
    dayName = "Unknown";  
    break;  
} 

Following the switch Statement Rules 

The switch statement is very useful, but, unfortunately, you can't always use it when 

you might like to. Any switch statement you write must adhere to the following rules: 

• You can use switch only on primitive data types, such as int or string. With any 
other types, you'll have to use an if statement. 

• The case labels must be constant expressions, such as 42 or “42”. If you need to 
calculate your case label values at run time, you must use an if statement. 

• The case labels must be unique expressions. In other words, two case labels 
cannot have the same value. 

• You can specify that you want to run the same statements for more than one 
value by providing a list of case labels and no intervening statements, in which 

case, the code for the final label in the list is executed for all cases. However, if a 

label has one or more associated statements, execution cannot fall through to 
subsequent labels, and the compiler generates an error. For example: 

• switch (trumps)  
• {  
• case Hearts :  
• case Diamonds :      // Fall-through allowed – no code between labels  

•     color = "Red";   // Code executed for Hearts and Diamonds  
•     break;  
• case Clubs :  

•     color = "Black";  
• case Spades :        // Error – code between labels  
•     color = "Black";  
•     break;  

} 

NOTE 
The break statement is the most common way to stop fall-through, but you can also use 

a return statement or a throw statement. The throw statement is described in Chapter 

6, “Managing Errors and Exceptions.” 
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In the following exercise, you will complete a program that reads the characters of a 
string and maps each character to its XML representation. For example, the '<' character 

has a special meaning in XML (it's used to form elements) and must be translated into 
"&lt;". You will write a switch statement that tests the value of the character and traps 

the special XML characters as case labels. 

Write switch statements 

1. Start Visual Studio 2005. 

2. Open the SwitchStatement project, located in the \Microsoft Press\Visual CSharp 
Step by Step\Chapter 4\SwitchStatement folder in your My Documents folder. 

3. On the Debug menu, click Start Without Debugging. 

Visual Studio 2005 builds and runs the application. There are two text boxes 
separated by a Copy button. 

            

 

4. Type the following sample text into the upper text box: 

inRange = (lo <= number) && (number <= hi); 

No Fall-Through 

Because of the no fall-through rule, you can freely rearrange the sections of a switch statement without 

affecting its meaning (including the default label, which by convention is usually placed as the last label, but 

does not have to be). 

C and C++ programmers should note that the break statement is mandatory for every case in a switch 

statement (even the default case). This requirement is a good thing; it is very common in C or C++ programs 

to forget the break statement, allowing execution to fall through to the next label and leading to bugs that are 

very difficult to spot. 

If you really want to, you can mimic fall-through in C# by using a goto statement to go to the following case 

or default label. This usage is not recommended though, and this book does not show you how to do it! 
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5. Click Copy. 

The statement is copied verbatim into the lower text box, and no translation of the 

'<' character occurs. 

6. Close the form. 
7. Display the code for Form1.cs in the Code and Text Editor window. Locate the 

copyOne method. 

The copyOne method copies one character from the upper text box to the lower 

text box. At the moment, copyOne contains a switch statement with a single 
default section. 

In the following few steps, you will modify this switch statement to convert 

characters that are significant in XML to their XML mapping. For example, the '<' 

character will be converted to the string "&lt;". 

8. Add the following statements to the switch statement, above the default label: 

case '<' :  
    target.Text += "&lt;";  
    break;  

case '>' :  
    target.Text += "&gt;";  
    break;  

case '&' :  
    target.Text += "&amp;";  
    break;  
case '\"' :  

    target.Text +=  "&#34;";  
    break;  
case '\'' :    

    target.Text += "&#39;";  
    break; 

NOTE 
The back-slash (\) in the final two cases is an escape character that causes the 

following characters (" and ') to be treated literally, rather than as characters 
delimiting a string or character constant. 

9. On the Debug menu, click Start Without Debugging. 

Visual Studio 2005 builds and runs the application. 

10. Type the following statement into the upper text box: 

           inRange = (lo <= number) && (number <= hi); 

11. Click Copy. 

The statement is copied into the lower text box. This time, each character 

undergoes the XML mapping implemented in the switch statement. 
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12. Close the form. 

• If you want to continue to the next chapter 

Keep Visual Studio 2005 open, and turn to Chapter 5. 

• If you want to exit Visual Studio 2005 now 

On the File menu, click Exit. If you see a Save dialog box, click Yes. 

Chapter 4 Quick Reference 
 
To Do this Example 

Determine whether two values are 

equivalent 

Use the == or != 

operator. 

answer == 42 

Compare the value of two 
expressions 

Use the <, <=, >, or 
>= operator. 

age >= 21 

Declare a Boolean variable Use the bool keyword as 
the type of the variable. 

bool inRange; 

Create a Boolean expression that is 

true only if two other conditions are 
true 

Use the && operator. inRange = (lo <= number)  
      &&  (number <= hi); 

Create a Boolean expression that is 
true if either of two other conditions 

is true 

Use the || operator. outOfRange = (number < lo)  
        ||  (hi < number); 

Run a statement if a condition is 
true 

Use an if statement. if (inRange)  
  process(); 

Run more than one statement if a 
condition is true 

Use a block. if (seconds == 59)  
{  
    seconds = 0;  

    minutes++;  
} 

Associate different statements with 

different values of a controlling 

expression 

Use a switch statement. switch (current)  

{  
  case '<':   
          ...  

          break;   
  default :  
          ...  
          break;  

}  

 

Chapter 5 

Using Compound Assignment and Iteration Statements 
 

After completing this chapter, you will be able to: 

• Update the value of a variable by using compound assignment operators. 
• Write while, for, and do iteration statements. 

• Step through a do method, and watch as the values of the variables change. 
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In Chapter 4, “Using Decision Statements,” you learned how to use the if and switch 

constructs to selectively run statements. In this chapter, you'll see how to use a variety 
of iteration (or looping) statements to repeatedly run one or more statements. When 

you write iteration statements, you usually need to control the number of iterations that 
you perform. You can achieve this by using a variable, updating its value with each 

iteration, and stopping the process when the variable reaches a particular value. 
Therefore, you'll also learn about the special assignment operators that you should use 

to update the value of a variable in these circumstances. 

Using Compound Assignment Operators 

You've already seen how to use arithmetic operators to create new values. For example, 
the following statement uses the + operator to create a value that is 42 greater than the 
variable answer. The new value is then written to the console: 

Console.WriteLine(answer + 42); 

You've also seen how to use assignment statements to change the value of a variable. 
The following statement uses the assignment operator to change the value of answer to 

42: 

answer = 42; 

If you want to add 42 to the value of a variable, you can combine the assignment 
operator and the addition operator. For example, the following statement adds 42 to 

answer. In other words, after this statement runs, the value of answer is 42 more than it 
was before: 

answer = answer + 42; 

Although this statement works, you'll probably never see an experienced programmer 
write this. Adding a value to a variable is so common that Microsoft Visual C# lets you 

perform this task in shorthand manner by using the compound assignment operator, 
+=. To add 42 to answer, an experienced programmer would write the following 

statement: 

answer += 42; 

You can use this shortcut to combine any arithmetic operator with the assignment 
operator, as the following table shows. These operators are collectively known as the 

compound assignment operators. 

Don't write this Write this 

variable = variable * number; variable *= number; 

variable = variable /  number; variable /= number; 

variable = variable % number; variable %= number; 

variable = variable + number; variable += number; 

variable = variable -  number; variable -= number; 
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TIP 

The compound assignment operators share the same precedence and right associativity 
as the simple assignment operator. 

The += operator also functions on strings; it appends one string to the end of another. 
For example, the following code displays “Hello John” on the console: 

string name = "John";  
string greeting = "Hello ";  

greeting += name;  
Console.WriteLine(greeting); 

You cannot use any of the other compound assignment operators on strings. 

NOTE 

Use the ++ and -- operators instead of a compound assignment operator when 
incrementing or decrementing a variable by 1. For example, replace:  
count += 1; 

with  
count++; 

 

Writing while Statements 

You use a while statement to repeatedly run a statement while a Boolean expression is 
true. The syntax of a while statement is: 

while ( booleanExpression )  
    statement 

The Boolean expression is evaluated and, if it's true, the statement runs and the Boolean 
expression is evaluated again. If the expression is still true, the statement is repeated 
and the expression evaluated again. This process continues until the Boolean expression 

evaluates to false when the while statement exits; execution then continues with the 
first statement after the while statement. A while statement shares many syntactic 

similarities with an if statement (in fact, the syntax is identical except for the keyword): 

• The expression must be a Boolean expression. 

• The Boolean expression must be written inside parentheses. 
• If the Boolean expression evaluates to false when first evaluated, the statement 

does not run. 
• If you want to perform two or more statements under the control of a while 

statement, you must use curly braces to group those statements in a block. 

Here's a while statement that writes the values 0 through 9 to the console: 

int i = 0;  

while (i != 10)  
{  
    Console.WriteLine(i);  
    i++;  

} 
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All while statements should terminate at some point. A common beginner's mistake is 

forgetting to include a statement to eventually cause the Boolean expression to evaluate 
to false and terminate the loop. In the example, the i++ statement performs this role. 

NOTE 

The variable, i, in the while loop controls the number of iterations that are performed. 
This is a very common idiom, and the variable that performs this role is sometimes 

called the Sentinel variable. 

In the following exercise, you will write a while loop to read the contents of a source file 

one line at a time and write each line to a text box in a Windows application. 

Write a while statement 

1. Using Visual Studio 2005, open the WhileStatement project, located in the 
\Microsoft Press\Visual CSharp Step by Step\Chapter 5\WhileStatement folder in 
your My Documents folder. 

2. On the Debug menu, click Start Without Debugging. 

Visual Studio 2005 builds and runs the Windows application. The application itself 

is a simple text file viewer, allowing you to select a file and display its contents. 

3. Click Open File. 

The Open dialog box opens. 

4. Navigate to the \Microsoft Press\Visual CSharp Step by Step\Chapter 5\ 

WhileStatement\WhileStatement folder in your My Documents folder. 
5. Select the Form1.cs file, and then click Open. 

The name of the source file, Form1.cs, appears in the small text box, but the 

contents of Form1.cs do not appear in the large text box. This is because the code 

that reads the contents of the source file and displays it in the large text box has 
not yet been implemented. You will add this functionality in the following steps. 

6. Close the form and return to Visual Studio 2005. 

7. Display the code for the file Form1.cs in the Code and Text Editor window. Locate 
the openFileDialog_FileOk method. 

This method is called when the user clicks the Open button after selecting a file in 
the Open dialog box. The body of the method is currently implemented as follows: 

string fullPathname = openFileDialog.FileName;  

FileInfo src = new FileInfo(fullPathname);  
filename.Text = src.Name;  
/* add while loop here */ 

The first statement declares a string variable called fullPathname and initializes it 

to the FileName property of the openFileDialog object. This statement initializes 
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fullPathname to the full name (including the folder) of the source file selected in 

the Open dialog box. 

NOTE 
The openFileDialog object is an instance of the OpenFileDialog component that is 

available in the Toolbox. This component provides methods that you can use to 
display the standard Windows Open dialog box, select a file, and retrieve name 

and path of the selected file. 

The second statement declares a FileInfo variable called src and initializes it to an 

object that represents the file selected in the Open dialog box. (FileInfo is a class 
provided by the Microsoft .NET Framework that allows you to manipulate files.) 

The third statement assigns the Text property of the filename control to the Name 

property of the src variable. The Name property of the src variable holds the name 
of the file selected in the Open dialog box without its folder. This assignment 

makes the name of the file appear in the filename component of the Windows 
form. 

8. Replace the /* add while loop here */ comment with the following statement: 

source.Text = ""; 

The source field is the large text box on the form. Setting its Text property to the 
empty string ("") clears any text that is currently displayed. 

9. Type the following statement after the line you just added to the 
openFileDialog_FileOk method: 

TextReader reader = src.OpenText(); 

This statement declares a TextReader variable called reader. (TextReader is 
another class, provided by the .NET Framework, that you can use for reading 
streams of characters from sources such as files. It is located in the System.IO 

namespace) The OpenFileDialog class provides the OpenText method for opening 
the file selected by the user in the Open dialog. The OpenText method returns a 

TextReader object. This statement initializes reader to the TextReader object 
returned from the src.OpenText method call. The reader variable can now be used 

to read the file chosen by the user. 

10. Type the following statements after the previous line you added to the 

openFileDialog_FileOk method: 

string line = reader.ReadLine();  
while (line != null)  
{  

    source.Text += line + '\n';  
    line = reader.ReadLine();  
}  

reader.Close(); 
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This code declares a string variable called line which is used to hold each line of 

text as the reader reads it from the file. The statement calls the reader.ReadLine 
method to read the first line from the file. This method returns either the next line 

of text, or a special value called null if there are no more lines to read. The result 
of this call is assigned to the line variable. 

The Boolean expression at the start of the while loop examines the value in the 

line variable. If it is not null, the body of the loop displays the line of text by 
appending it to the end of the Text property of the source TextBox, together with 

a newline character ('\n' – the ReadLine method of the TextReader object strips 
out the newline characters as it reads each line, so the code needs to add it back 

in again). The while loop then reads in the next line of text (this is the update part 

of the loop) before performing the next iteration. 

When the loop finishes, the call to the Close method of the TextReader object 
closes the file. 

TIP 

As you become more experienced with C# syntax, you will find that you can 

abbreviate the code in the while loop as follows:  

string line; 
while ((line = reader.ReadLine()) != null)  {     source.Text += line + '\n';  } 
reader.Close(); 

In this case, the Boolean expression at the start of the loop also performs the 
initialization and update. The ReadLine method is called, and the return value 
assigned to the line variable. However, an assignment statement actually yields a 

value—the value of the expression being assigned. Therefore, you can compare 
the result of an assignment expression by using a relational operator to produce a 

Boolean result. In this example, if the value assigned is null, the value of the 
assignment expression is null, and the comparison to null is true. 

11. On the Debug menu, click Start Without Debugging. 
12. Click Open File. 

The Open dialog box opens. 

13. Navigate to the \Microsoft Press\Visual CSharp Step by Step\Chapter 
5\WhileStatement\WhileStatement folder in your My Documents folder. Select the 

Form1.cs file and then click Open. 

This time the contents of the selected file are displayed in the text box: 
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14. In the text box, locate the openFileDialog_FileOk method. Verify that this 
method contains the code you just added. 

15. Click Close. 

You return to the Visual Studio 2005 programming environment. 

Writing for Statements 

Most while statements have the following general structure: 

initialization  

while (Boolean expression)  
{  
  statement  

  update control variable  
} 

A for statement allows you to write a more formal version of this kind of construct by 
combining the initialization, the Boolean expression, and the update (the loop's 

“housekeeping”). You'll find the for statement useful because it is much harder to forget 
any one of the three parts. Here is the syntax of a for statement: 

for (initialization; Boolean expression; update control variable)  
    statement 
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The while loop shown earlier, that displays the integers from 0 to 9, can be 

reconstructed as the following for loop: 

for (int i = 0; i != 10; i++)  
{  
    Console.WriteLine(i);  

} 

The initialization occurs once at the start of the loop. If the Boolean expression evaluates 
to true, the statement runs. The control variable update occurs and the Boolean 

expression is re-evaluated. If the condition is still true, the statement is executed again, 
the control variable is updated, the Boolean expression is evaluated again, and so on. 

Notice that the initialization occurs only once, and that the statement in the body of the 

loop always executes before the update occurs, and that the update occurs before the 
Boolean expression evaluates. 

You can omit any of the three parts of a for statement. If you omit the Boolean 
expression, it defaults to true. The following for statement runs forever: 

for (int i = 0; ;i++)  

{  
    Console.WriteLine("somebody stop me!");  
} 

If you omit the initialization and update parts, you have a strangely spelled while loop: 

int i = 0;  

for (; i != 10; )  
{  
    Console.WriteLine(i);  
    i++;  

} 

NOTE 
The initialization, Boolean expression, and update control variable parts of a for 

statement must always be separated by semicolons. 

If necessary, you can provide multiple initializations and multiple updates in a for loop 
(you can only have one Boolean expression). To achieve this, separate the various 
initializations and updates with commas, as shown in the following example: 

for (int i = 0, j = 10; i <= j; i++, j--)  

{  
    ...  
} 

TIP 
It's considered good style to use an explicit statement block for the body of if, while, and 

for statements even when the block contains only one statement. By writing the block, 
you make it easier to add statements to the block at a later date. Without the block, to 

add another statement, you'd have to remember to add both the extra statement and 
the braces, and it's very easy to forget the braces. 
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Understanding for Statement Scope 
You might have noticed that you can declare a variable in the initialization part of a for 
statement. That variable is scoped to the body of the for statement and disappears when 

the for statement finishes. This rule has two important consequences. First, you cannot 
use that variable after the for statement has ended, because it's no longer in scope. 

Here's an example: 
for (int i = 0; i != 10; i++)  

{  
    ...  
}  

Console.WriteLine(i); // compile time error 

Second, you can write two or more for statements next to each other that use the same 
variable name, because each variable is in a different scope. Here's an example: 

for (int i = 0; i != 10; i++)  

{  
    ...  
}  
 for (int i = 0; i != 20; i += 2) // okay  

{  
    ...  
} 
 

Writing do Statements 

The while and for statements both test their Boolean expression at the start of the loop. 
This means that if the expression evaluates to false on the very first test, the body of 
the loop does not run, not even once. The do statement is different; its Boolean 

expression is evaluated after each iteration, and so the body always executes at least 
once. 

The syntax of the do statement is as follows (don't forget the final semicolon): 

do  
    statement  
while (booleanExpression); 

Use a statement block if the body of the loop comprises more than one statement. 
Here's a version of the previous example that writes the values 0 through 9 to the 
console, this time using a do statement: 

int i = 0;  

do  
{  
    Console.WriteLine(i);  

    i++;  
}  
while (i != 10); 
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In the following exercise, you will write a do statement to convert a number to its string 
representation. 

 

Write a do statement 

1. Using Visual Studio 2005, open the DoStatement project, located in the \Microsoft 
Press\Visual CSharp Step by Step\Chapter 5\DoStatement folder in your My 

Documents folder. 
2. On the Debug menu, click Start Without Debugging. 

Visual Studio 2005 builds and runs the Windows application. 

The application displays a form that has two text boxes and the Show Steps 
button. When you type a positive number (the algorithm used doesn't work with 

negative numbers) in the upper text box, and click the Show Steps button, the 
lower text box shows the steps used to create a string representation of this 

number. 

NOTE 

This is simply an example showing you how to convert a number to a string using 

The break and continue Statements 

In Chapter 4, you saw the break statement being used to jump out of a switch 
statement. You can also use a break statement to jump out of the body of an iteration 

statement. When you break out of a loop, the loop exits immediately and execution 
continues at the first statement after the loop. Neither the update nor the continuation 

condition of the loop is re-run. 

In contrast, the continue statement causes the program to immediately perform the 
next iteration of the loop (after re-evaluating the Boolean expression). Here's a 

version of the previous example that writes the values 0 through 9 to the console, this 
time using break and continue statements: 

int i = 0;  
while (true)  
{  
    Console.WriteLine("continue " + i);  

    i++;  
    if (i != 10)  
        continue;  

    else  
        break;  
} 

This code is absolutely ghastly. Many programming guidelines recommend using 

continue cautiously or not at all because it is often associated with hard-to-understand 
code. The behavior of continue is also quite subtle. For example, if you execute a 

continue statement from inside a for statement, the update part runs before 
performing the next iteration of the loop. 
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a do loop. The .NET Framework provides the Convert.ToString method which does 

the same thing, and is the method you should really use to perform this task if you 
need it in your own applications. 

3. As an example, type 2693 in the upper text box, and then click Show Steps. 

The lower text box displays the steps used to create a string representation of 

2693: 

               

 

4. Close the window to return to the Visual Studio 2005 programming environment. 

5. Display the code for Form1.cs in the Code and Text Editor window. 
6. Locate the showSteps_Click method. This method runs when the user clicks the 

Show Steps button on the form. 

This method contains the following statements: 

int amount = System.Int32.Parse(number.Text);   

steps.Text = "";  
string current = "";  
do  
{  

    int digitCode = '0' + amount % 10;  
    char digit = Convert.ToChar(digitCode);  
    current = digit + current;  

    steps.Text += current + "\r\n";  
    amount /= 10;  
}  
while (amount != 0); 
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NOTE 

\r indicates a carriage return. When writing text to a multiline TextBox control, you 

need to output a carriage return and a newline to proceed to the next line and 
return the cursor to the start of the line. Without it, the text will all appear on the 

same line. 

The first statement converts the string value in the Text property of the number 
text box into an int using the Parse method of the System.Int32 class: 

int amount = System.Int32.Parse(number.Text);  

The second statement clears the text displayed in the lower text box (called steps) 
by setting its Text property to the empty string: 

steps.Text = ""; 

The third statement declares a string variable called current and initializes it to the 

empty string: 

string current = ""; 

The real work in this method is performed by the do statement which begins at the 
fourth statement: 

do  
{  
    ...  
}  

while (amount != 0); 

The algorithm repeatedly uses integer arithmetic and the modulus operator to 
divide the amount variable by 10; the remainder after each successive division 

constitutes the next digit in the string being built. Eventually amount is reduced to 
zero, and the loop finishes. Notice that the body must run at least once. This 

behavior is exactly what is required because even the number 0 has one digit. 

The first statement inside the do loop is: 

int digitCode = '0' + amount % 10; 

This statement declares an int variable called digitCode and initializes it to the 

result of the following expression: 

'0' + amount % 10 

This expression requires a little explanation! The value of '0'is the zero character. 
In the character set used by Windows, this character equates to the integer value 

48 (each character has its own unique character code which is an integer value). 
Similarly, the character code for '1' is 49, the character code for '2' is 50, and so 

on. 
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The value of amount % 10 is the remainder you get when you divide amount by 

10. For example, if amount contains the value 2693, then 2693 % 10 is 3. (2693 
divided by 10 is 269 with a remainder of 3.) Therefore, if amount equals 2693, 

then the expression '0' + amount % 10 is the same as '0' + 3, which is 51. This is 
the code for the character '3'. (The + operator performs an implicit cast, 

converting '0' to the integer value 48 to allow this expression to be evaluated.) 

The second statement inside the do loop is: 

char digit = Convert.ToChar(digitCode); 

This statement declares a char variable called digit and initializes it to the result of 

the Convert.ToChar(digitCode) method call. This method call returns the char with 
the integer character code value of the argument. In other words, the value of 

Convert.ToChar('0' + 3) is the value of ‘3'. 

The third statement inside the do loop is: 

current = digit + current; 

This statement prepends the char digit just calculated to the current string. Notice 
that this statement cannot be replaced by current += digit, because that would 

append the digit. 

The fourth statement inside the do loop is: 

steps.Text += current + "\r\n"; 

This statement appends another step to the Text property of the Steps text box. 

The final statement inside the do loop is: 

amount /= 10; 

This statement is the same as amount = amount / 10;. If the value of amount is 
2693, the value of amount after this statement runs is 269. Notice that each 

iteration through the do statement removes the last digit from amount and 
prepends that digit to the current string. 

In the final exercise, you will use the Visual Studio 2005 debugger to step through the 
previous do statement to help you understand how it works. 

Step through the do statement 

1. In the Code and Text Editor window, find the showSteps_Click method. 
2. Move the cursor to the first statement of the showSteps_Click method. 

The first statement is as follows: 

int amount = System.Int32.Parse(number.Text); 
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3. Right-click anywhere in the first statement and click Run To Cursor. 

Visual Studio 2005 builds and runs the application. 

4. When the form appears, type 2693 in the upper text box, and then click Show 

Steps. 

The program stops and you are placed in Visual Studio 2005 in debug mode. A 

yellow arrow in the left margin of the Code and Text Editor window indicates the 
current statement. 

5. Display the Debug toolbar if it is not visible (on the View menu, point to Toolbars 

and then select Debug). On the Debug toolbar, click the Windows drop-down 
arrow. 

The following menu appears: 

         

 

6. On the menu, click Locals. 

The Locals window appears. This window displays the name, value, and type of the 

local variables in the current method, including the amount local variable. Notice 
that the value of amount is currently zero: 
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1. On the Debug toolbar, click the Step Into button. 

The debugger runs the current statement: 

int amount = System.Int32.Parse(number.Text); 

The value of amount in the Locals window changes to 2693 and the yellow arrow 

moves to the next statement. 

2. Click the Step Into button. 

The debugger runs the statement: 

steps.Text = ""; 

This statement does not affect the Locals window because steps is a field of the 
form and not a local variable. The yellow arrow moves to the next statement. 

3. Click the Step Into button. 

The debugger runs the statement: 

string current = ""; 

The yellow arrow moves to the opening curly brace at the start of the do loop. 

4. Click the Step Into button. 

The yellow arrow moves to the first statement inside the do loop. The do loop 
contains two local variables of its own, digitCode and digit. Notice that these local 

variables have appeared in the Locals window and that the value of digitCode is 
zero. 

5. Click the Step Into button. 

The debugger runs the statement: 
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int digitCode = '0' + amount % 10; 

The value of digitCode in the Locals window changes to 51. This is because the 
value of the expression amount % 10 is 3 (the value of amount is 2693), and the 

code for character '3' is 51 (48 + 3). 

6. Click the Step Into button. 

The debugger runs the statement: 

char digit = Convert.ToChar(digitCode); 

The value of digit changes to '3' in the Locals window. The Locals window shows 
char values using both the underlying numeric value (in this case, 51) and also the 

character representation ('3'). The yellow arrow moves to the next statement 
inside the do loop. 

Note that in the Locals window, the value of the current variable is "". 

7. Click the Step Into button. 

The debugger runs the statement: 

current = current + digit; 

The value of current changes to "3" in the Locals window. 

8. Click the Step Into button. 

The debugger runs the statement: 

steps.Text += current + "\r\n"; 

This statement displays the text "3" in the steps text box, followed by a carriage 
return and newline character, to cause subsequent output to be displayed on the 

next line in the text box. 

In the Locals window, the value of amount is still 2693. 

9. Click the Step Into button. 

The debugger runs the statement: 

amount /= 10; 

The value of amount changes to 269 in the Locals window. The yellow arrow 
moves to the curly brace at the end of the do loop. 

10. Click the Step Into button 

The yellow arrow moves to the while statement. 
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11. Click the Step Into button. 

The debugger runs the statement: 

while (amount != 0); 

The value of amount is 269, and the expression 269 != 0 evaluates to true, so the 
do loop should perform another iteration. The yellow arrow jumps back to open 
curly brace at the start of the do loop. 

12. Click the Step Into button. 

The yellow arrow moves to the first statement inside the do loop again. 

13. Click the Step Into button 22 more times and watch the values of the local 

variables change in the Locals window. 

In the Locals window, the value of amount is now zero and the value of current is 
“2693”. The yellow arrow is on the continuation condition of the do loop: 

while (amount != 0); 

The value of amount is now 0, so the expression amount != 0 evaluates to false, 
so the do loop should terminate. 

14. Click the Step Into button. 

The debugger runs the statement: 

while (amount != 0); 

As predicted the do loop terminates, and the yellow arrow moves to the closing 
brace at the end of the showSteps_Click method. 

15. Click the Continue button. 

The form appears, displaying the four steps used to create a string representation 

of 2693: “3”, “93”, “693”, and “2693”. 

16. Close the form to return to the Visual Studio 2005 programming 

environment. 

Congratulations! You have successfully written meaningful while and do statements and 
used the Visual Studio 2005 debugger to step through the do statement. 

• If you want to continue to the next chapter 

Keep Visual Studio 2005 running and turn to Chapter 6, “Managing Errors and 
Exceptions.” 
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• If you want to exit Visual Studio 2005 now 

On the File menu, click Exit. If you see a Save dialog box, click Yes. 

Chapter 5 Quick Reference 
To Do this 

Add an amount to a variable Use the compound addition operator. For example: 

variable += amount; 

Subtract an amount from a variable Use the compound subtraction operator. For example: 

variable -= amount; 

Run one or more statements while a condition is true Use a while statement. For example: 

int i = 0;  

while (i != 10)  

{  

    Console.WriteLine(i);  

    i++;  

} 

Alternatively, use a for statement. For example: 

for (int i = 0; i != 10; i++)  

{  

    Console.WriteLine(i);  

}  

Repeatedly execute statements one or more times Use a do statement. For example: 

int i = 0;  

do  

{  

    Console.WriteLine(i);  

    i++;  

}  

while (i != 10); 

 

Chapter 6 

Managing Errors and Exceptions 

 
After completing this chapter, you will be able to: 

• Handle exceptions by using the try, catch, and finally statements. 
• Control integer overflow by using the checked and unchecked keywords. 

• Raise exceptions from your own methods by using the throw keyword. 
• Ensure that code always runs, even after an exception has occurred, by using a 

finally block. 

You have now seen the core C# statements you need to know to read and write 
methods; declare variables; use operators to create values; write if and switch 
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statements to selectively run code; and write while, for, and do statements to 

repeatedly run code. However, the previous chapters haven't considered the possibility 
(or probability) that things can go wrong. It is very difficult to ensure that a piece of 

code always works as expected. Failures can occur for a large number of reasons, many 
of which are beyond your control as a programmer. Any applications that you write must 

be capable of detecting failures and handling them in a graceful manner. In this final 
chapter of Part I, “Introducing Microsoft Visual C# and Microsoft Visual Studio 2005,” 

you'll learn how C# throws exceptions to signal that an error has occurred, and how to 
use the try, catch, and finally statements to catch and handle the errors that these 

exceptions represent. By the end of this chapter, you'll have a solid foundation in C#, 
which you will build on in Part II, “Understanding the C# Language.” 

Coping with Errors 

It's a fact of life that bad things sometimes happen. Tires get punctured, batteries run 

down, screwdrivers are never where you left them, and users of your applications 
behave in an unpredictable manner. Errors can occur at almost any stage when a 

program runs, so how do you detect them and attempt to recover? Over the years, a 
number of mechanisms have evolved. A typical approach adopted by older systems such 

as Unix involved arranging for the operating system to set a special global variable 
whenever a method failed. Then, after each call to a method, you checked the global 

variable to see whether the method failed. This solution has a number of shortcomings: 

• The main program logic becomes intertwined with alternating code to check and 
handle the errors. The program quickly becomes hard to understand. 

• The error checking and handling code is typically very repetitive and can easily 

double the size of the program. A large program is harder to understand than a 
small program simply because it's larger. Duplicate code is always a warning sign 

that an application can be structured in a better manner. 
• The error codes used by a global variable, such as –1 used by Unix systems, are 

not inherently meaningful. What does –1 mean? Integer error codes don't describe 
the errors they represent. They're very programmatic. Once again, the program 

becomes harder to understand and maintain. 
• It's just too easy to ignore the error condition and assume that a method being 

called works every time. Many programmers don't like to read documentation, and 
fewer like to write it, so the method might not be documented with information 

about the errors it can cause. 

For these reasons, C# and most other modern object-oriented languages don't handle 

errors in this way. It's just too painful. They use exceptions instead. If you want to write 
robust C# programs, you need to know about exceptions. 

Trying Code and Catching Exceptions 

C# makes it easy to separate the code that implements the main flow of the program 
from the error handling code, by using exceptions and exception handlers. To write 

exception-aware programs, you need to do two things: 
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1. Write your code inside a try block (try is a keyword). When the code runs, it 

attempts to execute all the statements inside the try block, and if none of the 
statements generates an exception, they all run, one after the other, to 

completion. However, if an error condition occurs, execution jumps out of the try 
block and into a catch handler. 

2. Write one or more catch handlers (catch is a keyword) immediately after the try 
block to handle any possible error conditions. If any one of the statements inside 

the try block causes an error, the runtime generates and throws an exception. The 
runtime then examines the catch handlers after the try block and transfers control 

directly to a matching handler. Catch handlers are designed to trap particular 
exceptions, allowing you to provide different handlers for the different errors that 

can happen. 

Here's an example that uses a try block to attempt to convert some text fields into 

integer values, call a method to calculate a value, and write the result to a text field. 
Converting a string to an integer requires that the string contains a valid representation 

and not some arbitrary sequence of characters. If the string contains invalid characters, 
the Int32.Parse method throws a FormatException, and execution transfers to the 

corresponding catch handler. When the catch handler finishes, the program continues 
with the first statement after the handler: 

try  

{  
    int leftHandSide = Int32.Parse(leftHandSideOperand.Text);  
    int rightHandSide = Int32.Parse(rightHandSideOperand.Text);  

    int answer = doCalculation(leftHandSide, rightHandSide);  
    result.Text = answer.ToString();  
}  
catch (FormatException fEx)  

{  
    // Handle the exception  
    ...  

} 

Handling an Exception 

The catch handler uses syntax similar to that used by a method parameter to specify the 

exception to be caught. In the previous example, when a FormatException is thrown, the 
fEx variable is populated with an object containing the details of the exception. The 

FormatException type has a number of fields that you can examine to determine the 
exact cause of the exception. Many of these fields are common to all exceptions. For 

example, the Message field contains a text description of the error that caused the 
exception. You can use this information when handling the exception, recording the 

details to a log file, or outputting a meaningful message to the user and asking them to 
try again, for example. 

Unhandled Exceptions 

What happens if a try block throws an exception and there is no corresponding catch 
handler? In the previous example, it is possible that the leftHandSideOperand field 

contains the string representation of a valid integer, but the integer that it represents is 
outside of the range of valid integers supported by C# (for example, “2147483648”). In 
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this case, the Int32.Parse statement will throw an OverflowException, which will not be 

caught by the catch handler as it specifies that it catches FormatException. If the try 
block is part of a method, the method finishes and returns to the calling method. If the 

calling method uses a try block, the common language runtime attempts to locate a 
matching catch handler after the try block and execute it. If the calling method does not 

use a try block, or there is no matching catch handler, the calling method terminates 
and returns to its caller where the process is repeated. If a matching catch handler is 

eventually found, it runs and execution continues with the first statement after the catch 
handler in the catching method. 

IMPORTANT 

Notice that after catching an exception, execution continues in the method containing 

the catch block that caught the exception. Control does not return to the method that 
caused the exception. 

If, after cascading back through the list of calling methods, the common language 
runtime is unable to find a matching catch handler, the program terminates with an 
unhandled exception. If you are running the application in Visual Studio 2005 in Debug 

mode (you selected Start Debugging in the Debug menu to run the application), the 
following information dialog box appears and the application drops into the debugger, 

allowing you to determine the cause of the exception: 
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Using Multiple catch Handlers 

The previous discussion highlighted how different errors throw different kinds of 
exceptions to represent different kinds of failure. To cope with these situations, you can 

supply multiple catch handlers, one after the other, like this: 

try  
{  
    int leftHandSide = Int32.Parse(leftHandSideOperand.Text);  

    int rightHandSide = Int32.Parse(rightHandSideOperand.Text);  
    int answer = doCalculation(leftHandSide, rightHandSide);  
    result.Text = answer.ToString();  

}  
catch (FormatException fEx)  
{  
    //...  

}  
catch (OverflowException oEx)  
{  

    //...  
} 

Catching Multiple Exceptions 

The exception-catching mechanism of the common language runtime is pretty 
comprehensive. There are many different exceptions defined in the .NET Framework, 

and any programs you write will be able to throw most of them! It is highly unlikely that 
you will want to write catch handlers for every possible exception that your code can 

throw. So how do you ensure that all possible exceptions are caught and handled? 

The answer to this question lies in the way the different exceptions are related to each 
other. Exceptions are organized into families called inheritance hierarchies (you will 

learn about inheritance in Chapter 12, “Working with Inheritance”). FormatException 
and OverflowException both belong to a family called SystemException, as do a number 

of other exceptions. Rather than catching each of these exceptions individually, you can 

create a handler that catches SystemException. SystemException is itself a member of a 
family simply called Exception, which is the great-grandaddy of all exceptions. If you 

catch Exception, the handler traps every possible exception that can occur. 

NOTE 
The Exception family includes a wide variety of exceptions, many of which are intended 

for use by various parts of the common language runtime. Some of these are somewhat 
esoteric, but it is still useful to understand how to catch them. 

The next example shows how to catch all possible system exceptions: 

try  
{  
    int leftHandSide = Int32.Parse(leftHandSideOperand.Text);  

    int rightHandSide = Int32.Parse(rightHandSideOperand.Text);  
    int answer = doCalculation(leftHandSide, rightHandSide);  



SREEKANTH                                                                                                                                                                  C# STEP BY STEP 

90 

 

    result.Text = answer.ToString();  
}  

catch (Exception ex) // this is a general catch handler  
{  
    //...  
} 

TIP 
If you wish to catch Exception, you can actually omit its name from the catch handler, 

because it is the default exception:  
catch  {      // ...  } 

However, this is not always recommended. The exception object passed in to the catch 
handler can contain useful information concerning the exception, which is not accessible 

when using this version of the catch construct. 

There is one final question you should be asking at this point: What happens if the same 
exception matches multiple catch handlers at the end of a try block? If you catch 

FormatException and Exception in two different handlers, which one will run (or will both 
execute)? 

When an exception occurs, the first handler found by the common language runtime that 
matches the exception is used, and the others are ignored. What this means is, if you 

place a handler for Exception before a handler for FormatException, the FormatException 
handler will never run. Therefore you should place more specific catch handlers above a 

general catch handler after a try block. If none of the specific catch handlers matches 
the exception, the general catch handler will. 

In the following exercise, you will write a try block and catch an exception. 

Write a try/catch statement 

1. Start Visual Studio 2005. 
2. Open the MathsOperators solution located in the \Microsoft Press\Visual CSharp 

Step By Step\Chapter 6\MathsOperators folder in your My Documents folder. 

This is a variation on the program that you first saw in Chapter 2, “Working with 

Variables, Operators, and Expressions.” It was used to demonstrate the different 
arithmetic operators. 

3. On the Debug menu, click Start Without Debugging. 

NOTE 
If you run the application in Debug mode, it drops into the debugger when an 

unhandled exception occurs. This is not what we want in this example, so ensure 
that you click Start Without Debugging. 

Visual Studio 2005 builds and runs the Windows application. The Exceptions Form 

appears. 
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You are now going to deliberately enter some text that is not valid in the left 

operand text box. This operation will demonstrate the lack of robustness in the 
current version of the program. 

4. Type John in the left operand text box, and then click Calculate. 

A dialog box reports an unhandled exception; the text you entered in the left 

operand text box caused the application to fail. 

 

  

5. Click Details in the Exception dialog box to display the information concerning the 
exception: 
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From the first few lines of text, you can ascertain that the exception was thrown 

by the call to Int32.Parse inside the calculate_Click method. 

6. Click Quit to close the Exceptions dialog box and return to Visual Studio 2005. 
7. Display the code for the file Form1.cs in the Code pane. 

8. Locate the calculate_Click method. Add a try block around the four statements 
inside this method, so that the code looks exactly as follows: 

try  
{  
    int leftHandSide = Int32.Parse(leftHandSideOperand.Text);  
    int rightHandSide = Int32.Parse(rightHandSideOperand.Text);  

    int answer = doCalculation(leftHandSide, rightHandSide);  
    result.Text = answer.ToString();  

} 

9. Add a catch block after this new try block, as follows: 

catch (FormatException fEx)  

{  
    result.Text = fEx.Message;  

} 

This catch handler catches the FormatException thrown by Int32.Parse, and then 

writes its Message text to the Text property of the result text box at the bottom of 
the form. 

10. On the Debug menu, click Start Without Debugging. 

11. Type John in the left operand text box, and then click Calculate. 

The catch handler successfully catches the FormatException, and the message 

“Input string was not in a correct format.” is written to the Result text box. The 
application is now a bit more robust. 
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12. Click Quit to return to the Visual Studio 2005 programming environment. 

 

Using Checked and Unchecked Integer Arithmetic 

In Chapter 2, you learned how to use binary arithmetic operators such as + and * on 
primitive data types such as int and double. You also saw that the primitive data types 

have a fixed size. For example, a C# int is 32 bits. Because int has a fixed size, you 
know exactly the range of value that it can hold: it is –2147483648 to 2147483647. 

TIP 
If you want to determine the minimum or maximum value of int in code, you can use 

the Int32.MinValue or Int32.MaxValue fields. 

The fixed size of the int type creates a problem. For example, what happens if you add 1 
to an int whose value is currently 2147483647? The answer is that it depends on how 

the application is compiled. By default, the C# compiler generates code that allows the 

calculation to silently overflow. In other words, you get the wrong answer. (In fact, the 
calculation wraps around to the largest negative integer value and the result generated 

is –2147483648.) The reason for this behavior is performance: integer arithmetic is a 
common operation in almost every program, and adding the overhead of overflow 

checking to each integer expression could lead to very poor performance. In many 
cases, the risk is acceptable because you know (or hope!) that your int values won't 

reach their limits. If you don't like this approach, you can turn on overflow checking by 
setting. 

TIP 

You can enable and disable overflow checking in Visual Studio 2005 by setting the 

project properties. On the Project menu, click YourProject Properties (where YourProject 
is the name of your project). In the project properties dialog box, click the Build tab. 

Click the Advanced button in the lower-right corner of the page. In the Advanced Build 
Settings dialog box, select or clear the “Check for arithmetic overflow/underflow” check 

box. 

Regardless of how you compile an application, you can use the checked and unchecked 
keywords to selectively turn on and off integer arithmetic overflow checking in parts of 

an application that you think need it. These keywords override the compiler option. 

Writing checked Statements 

A checked statement is a block preceded by the checked keyword. All integer arithmetic 
in a checked statement always throws an OverflowException if an integer calculation in 

the block overflows, as shown in this example: 

int number = Int32.MaxValue;  
checked  
{  

    int willThrow = number++;  
    Console.WriteLine("this won't be reached");  
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} 

IMPORTANT 

Only integer arithmetic directly inside the checked block is checked. For example, if one 
of the checked statements is a method call, the checking does not encapsulate the 

method call. 

You can also use the unchecked keyword to create an unchecked block statement. All 

integer arithmetic in an unchecked block is not checked and never throws an 
OverflowException. For example: 

int number = Int32.MaxValue;  

unchecked  
{  
    int wontThrow = number++;  
    Console.WriteLine("this will be reached");  

} 

IMPORTANT 

You cannot use the checked and unchecked keywords to control floating point (non-
integer) arithmetic. The checked and unchecked keywords control only integer 

arithmetic. Floating point arithmetic never throws OverflowException—not even when 
you divide by 0.0 (the .NET Framework has a representation for infinity). 

Writing Checked Expressions 

You can also use the checked and unchecked keywords to control overflow checking on 
integer expressions by preceding just the individual parenthesized expression with the 

checked or unchecked keyword, as shown in this example: 

int wontThrow = unchecked(Int32.MaxValue + 1);  
int willThrow = checked(Int32.MaxValue + 1); 

The compound operators (such as += and -=) and the increment (++) and decrement 
(--) operators are arithmetic operators and can be controlled by using the checked and 
unchecked keywords. Remember, x += y; is the same as x = x + y;. 

In the following exercise, you will see how to perform checked arithmetic when using 
Visual Studio 2005. 

Use checked expressions 

1. Return to Visual Studio 2005, and display the MathsOperators solution. 
2. On the Debug menu, click Start Without Debugging. 

You will now attempt to multiply two large values. 

3. Type 9876543 in the left operand text box, type 9876543 in the right operand text 

box, select the Multiplication option under Operators, and then click Calculate. 

The value –1195595903 appears in the Result text box on the form. This is a 

negative value, which cannot possibly be correct. This value is the result of a 
multiplication operation that silently overflowed the 32-bit limit of the int type. 
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4. Click Quit to return to the Visual Studio 2005 programming environment. 

5. In the Code pane displaying Form1.cs, locate the multiplyValues method: 

private int multiplyValues(int leftHandSide, int rightHandSide)  
{  
    expression.Text = leftHandSide.ToString() + " * " + rightHandSide.ToString();  

    return leftHandSide * rightHandSide;  
} 

The return statement contains the multiplication operation that is silently 
overflowing. 

6. Edit the return statement so that the return value is checked. The multiplyValues 
method should look exactly as follows: 

private int multiplyValues(int leftHandSide, int rightHandSide)  

{  
    expression.Text = leftHandSide.ToString() + " * " + rightHandSide.ToString();  
    return checked(leftHandSide * rightHandSide);  

} 

The multiplication is now checked and will throw an OverflowException rather than 
silently returning the wrong answer. 

7. In the Code pane, locate the calculate_Click method. 

8. Add the following catch handler immediately after the existing FormatException 
catch handler in the calculate_Click method: 

catch (OverflowException oEx)  

{  
    result.Text = oEx.Message;  

} 

TIP 

The logic of this catch handler is the same as that for the FormatException catch 
handler. However, it is still worth keeping these handlers separate rather than 

simply writing a generic Exception catch handler as you might decide to handle 
these exceptions differently in the future. 

9. On the Debug menu, click Start Without Debugging to build and run the 

application. 
10. Type 9876543 in the left operand text box, type 9876543 in the right 

operand text box, select the Multiplication option under Operators, and then click 

Calculate. 

The second catch handler successfully catches the OverflowException and displays 
the message “Arithmetic operation resulted in an overflow” in the Result text box. 

11. Click Quit to return to the Visual Studio 2005 programming environment. 

Throwing Exceptions 
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Suppose you are implementing a method called monthName that accepts a single int 

argument and returns the name of the corresponding month. For example, 
monthName(1) returns “January.” The question is: what should the method return when 

the integer argument is less than 1 or greater than 12? The best answer is that the 
method shouldn't return anything at all; it should throw an exception. The .NET 

Framework class libraries contain lots of exception classes specifically designed for 
situations such as this. Most of the time, you will find that one of these classes describes 

your exceptional condition. (If not, you can easily create your own exception class, but 
you need to know a bit more about the C# language before you can do that.) In this 

case, the existing .NET Framework ArgumentOutOfRangeException class is just right: 

public static string monthName(int month)  
{  

   switch (month)  
   {  
      case 1 :   
          return "January";  

      case 2 :  
          return "February";   
      ...  
      case 12 :  

          return "December";   
      default :  
          throw new ArgumentOutOfRangeException("Bad month");  

   }  
} 

Notice how the default case uses a throw statement to generate an exception. The throw 
statement needs an exception to throw. This example uses an expression that creates a 

new ArgumentOutOfRangeException object. The object is initialized with a string that 
will populate its Message property, by using a constructor. Constructors are covered in 

detail in Chapter 7, “Creating and Managing Classes and Objects.” 

In the following exercises, you will add code that throws and catches exceptions to the 

MathsOperators project. 

Throw your own exception 

1. Return to Visual Studio 2005, and make sure the MathsOperators solution is still 

open. 
2. On the Debug menu, click Start Without Debugging. 

3. Type 24 in the left operand text box, type 36 in the right operand text box, and 
then click Calculate. 

The value 0 ppears in the Result text box. The fact that you have not selected an 

operator option is not immediately obvious. It would be useful to write a diagnostic 
message in the Result text box. 

4. Click Quit to return to the Visual Studio 2005 programming environment. 
5. In the Code pane displaying Form1.cs, locate and examine the doCalculation 

method. It looks like this: 
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private int doCalculation(int leftHandSide, int rightHandSide)  
{  

    int res = 0;  
    if (addition.Checked)  
        res = addValues(leftHandSide, rightHandSide);  
    else if (subtraction.Checked)  

        res = subtractValues(leftHandSide, rightHandSide);  
    else if (multiplication.Checked)  
        res = multiplyValues(leftHandSide, rightHandSide);  
    else if (division.Checked)  

        res = divideValues(leftHandSide, rightHandSide);  
    else if (remainder.Checked)  
        res = remainderValues(leftHandSide, rightHandSide);  

    return res;  
} 

The addition, subtraction, multiplication, division, and remainder fields are the 
radio buttons that appear in the Operators group on the form. Each radio button 

has a Checked Boolean property that has the value true if the option is selected. 
The cascading if statement examines each radio button in turn to find out which 

one is selected. If none of the options are selected, none of the if statements will 
be true and the res variable will remain at its initial value (0). This variable holds 

the value that is returned by the method. 

IMPORTANT 

Do not confuse the C# checked keyword with the Checked property of a radio 
button—they are not related in any way. 

You could try to solve the problem by adding one more else statement to the if-

else cascade, to write a message to the result text box, as follows: 

if (addition.Checked)  

    res = addValues(leftHandSide, rightHandSide);  
...  
else if (remainder.Checked)  
    res = remainderValues(leftHandSide, rightHandSide);  

else  
    result.Text = "no operator selected"; 

However, this solution is not a good idea as it is not really the purpose of this 
method to output messages. With this code, you would have two methods in the 

program that write diagnostic messages to the result text box— calculate_Click 
and doCalculation. It is better to separate the detection and signaling of an error 

from the catching and handling of that error. 

6. Add one more else statement to the list of if-else statements (immediately before 

the return statement) and throw an InvalidOperationException exactly as follows: 

else  
    throw new InvalidOperationException("no operator selected"); 

7. On the Debug menu, click Start Without Debugging to build and run the 

application. 
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8. Type 24 in the left operand text box, type 36 in the right operand text box, and 

then click Calculate. 

An Exception message box appears. 

9. Click Details. 

The message tells you that an InvalidOperationException has been thrown with the 

string “no operator selected.” 

 

1. Click Quit in the Exceptions message box. 

The application terminates and you return to Visual Studio 2005. 

Now that you have written a throw statement and verified that it throws an exception, 

you will write a catch handler to catch this exception. 

Catch your own exception 

1. In the Code pane displaying Form1.cs, locate the calculate_Click method. 
2. Add the following catch handler immediately below the existing two catch handlers 

in the calculate_Click method: 

catch (InvalidOperationException ioEx)  
{  
    result.Text = ioEx.Message;  

} 

This code will catch the InvalidOperationException that is thrown when no operator 
option is selected. 

3. On the Debug menu, click Start Without Debugging. 
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4. Type 24 in the left operand text box, type 36 in the right operand text box, and 

then click Calculate. 

The message “no operator selected” appears in the Result text box. 

5. Click Quit. 

The application is now a lot more robust than it was. However, several exceptions 

could still arise that would not be caught and might cause the application to fail. 
For example, if you attempt to divide by zero, an unhandled 

DivideByZeroException will be thrown (integer division by zero does throw an 
exception, unlike floating point division by zero). One way to solve this would be 

to write an ever larger number of catch handlers inside the calculate_Click 
method. However, a better solution would be to add a general catch handler that 

catches Exception to the end of the list of catch handlers. This will trap all 
unhandled exceptions. 

TIP 
The decision of whether to explicitly catch all unhandled exceptions in a method 

depends on the nature of the application you are building. In some cases, it makes 
sense to catch exceptions as close to the point that they occur as possible, but in 

other situations it is more useful to let an exception propagate back up the method 
call stack to be handled by the method that invoked the routine that threw the 

exception. 

6. In the Code pane displaying Form1.cs, locate the calculate_Click method. 

7. Add the following catch handler to the end of the list of existing catch handlers: 

catch (Exception ex)  
{  
    result.Text = ex.Message;  

} 

This catch handler will catch all hitherto unhandled exceptions, whatever their 
specific type. 

8. On the Debug menu, click Start Without Debugging. 

You will now attempt some calculations known to cause exceptions and confirm 

that they are all caught. 

9. Type 24 in the left operand text box, type 36 in the right operand text box, and 

then click Calculate. Confirm that the diagnostic message “no operator selected” 
still appears in the Result text box. This message was generated by the 

InvalidOperationException handler. 
10. Type John in the left operand text box, and then click Calculate. Confirm that 

the diagnostic message “Input string was not in a correct format” appears in the 
Result text box. This message was generated by the FormatException handler. 

11. Type 24 in the left operand text box, type 0 in the right operand text box, 
select the Divide option under Operators, and then click Calculate. Confirm that 
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the diagnostic message “Attempted to divide by zero” appears in the Result text 

box. This message was generated by the general Exception handler. 
12. Click Quit. 

Using a finally Block 

It is important to remember that when an exception is thrown, it changes the flow of 
execution through the program. This means you can't guarantee that a statement will 

always run when the previous statement finishes, because the previous statement might 
throw an exception. Look at the following example. It's very easy to assume the call to 

reader.Close will always occur. After all, it's right there in the code: 

TextReader reader = src.OpenText();  
string line;  
while ((line = reader.ReadLine()) != null)  

{  
    source.Text += line + "\n";  
}  
reader.Close(); 

Sometimes it's not an issue if one particular statement does not run, but on many 
occassions it can be a big problem. If the statement releases a resource that was 
acquired in a previous statement, then failing to execute this statement results in the 

resource being retained. This example is just such a case: If the call to src.OpenText 

succeeds, then it acquires a resource (a file handle) and you must ensure that you call 
reader.Close to release the resource. If you don't, sooner or later you'll run out of file 

handles and be unable to open more files (if you find file handles too trivial, think of 
database connections instead). 

The way to ensure a statement is always run, whether or not an exception has been 

thrown, is to write that statement inside a finally block. A finally block occurs 
immediately after a try block, or immediately after the last catch handler after a try 

block. As long as the program enters the try block associated with a finally block, the 
finally block will always be run, even if an exception occurs. If an exception is thrown 

and caught locally, the exception handler executes first, followed by the finally block. If 

the exception is not caught locally (the common language runtime has to search through 
the list of calling methods to find a handler), the finally block runs first. In any case, the 

finally block always executes. 

The solution to the reader.Close problem is as follows: 

TextReader reader = null;   
try  

{  
    reader = src.OpenText();  
    string line;  
    while ((line = reader.ReadLine()) != null)  

    {  
        source.Text += line + "\n";  
    }  

}  
finally  
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{  
    if (reader != null)  

    {  
        reader.Close();  
    }  
} 

Even if an exception is thrown, the finally block ensures that the reader.Close statement 
always executes. You'll see another way to solve this problem in Chapter 13, “Using 
Garbage Collection and Resource Management.” 

• If you want to continue to the next chapter 

Keep Visual Studio 2005 running and turn to Chapter 7. 

• If you want to exit Visual Studio 2005 now 

On the File menu, click Exit. If you see a Save dialog box, click Yes. 

Chapter 6 Quick Reference 
To Do this 

Throw an exception Use a throw statement. For example: 

throw new FormatException(source); 

Ensure that integer arithmetic is 
always checked for overflow 

Use the checked keyword. For example: 

int number = Int32.MaxValue;  
checked  
{  

    number++;  
} 

Catch a specific exception Write a catch handler that catches the specific 

exception class. For example: 

try  
{  

    ...  
}  
catch (FormatException fEx)  

{  
    ...  
} 

Catch all exceptions in a single catch 
handler 

Write a catch handler that catches Exception. For 
example: 

try  

{  
    ...  
}  
catch (Exception ex)  

{  
    ...  
} 
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Ensure that some code will always 

be run, even if an exception is 
thrown 

Write the code inside a finally block. For example: 

try  

{  
    ...  
}  
finally  

{  
    // always run  
} 
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